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User Registration Request

Thank you for purchasing YOKOGAWA products.

Please register to the following Customer Portal Member Site.

You can use various services such as confirmation of purchased product information,
download of related materials, and newsletter.

https://myportal.yokogawa.com/
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Introduction

Thank you for purchasing the Dagstation DX1000/DX1000N
(DX).This manual describes the basic operating procedures and
installation and wiring procedures of the DX1000/DX1000N. To
ensure correct use, please read this manual and the manuals
below thoroughly before beginning operation.

For the product specifications, see the general specifications.

DAQSTANDARD

Download the DAQSTANDARD (Application software) from the
following URL.

URL: https://www.yokogawa.com/ns/dxadv/download/

Paper Manual

Manual Title Manual No.

DX1000/DX1000N Operation Guide IM 04L41B01-02E
This manual.

Control of Pollution Caused by the Product IM 04L41B01-91C
Gives a description of pollution control.

About the Usage of Open Source Software  IM 04L41B01-
8121

Electronic Manuals

User’s manuals for the DX are available on the following web site:
http://www.yokogawa.com/ns/dxadv/im/

You need Adobe Reader 7.0 or later (but the latest version is
recommended) installed on the computer in order to open and read
the manuals.

Manual Title Manual No.

DX1000/DX1000N Operation Guide IM 04L41B01-02E
This is the electronic version of the paper manual.

DX1000/DX1000N User’s Manual IM 04L41B01-01E
Describes how to use the DX. The communication and
network functions, custom display functions, and some of the
options are excluded.

DX1000/DX1000N/DX2000
Multi Batch (/BT2) User’s Manual
Describes how to use the multi batch function (/BT2 option).

IM 04L41B01-03E

DX1000/DX1000N/DX2000 Custom IM 04L41B01-04E
Display User’s Manual
Describes how to use the custom display function.

DX1000/DX1000N/DX2000 Advanced IM 04L41B01-

Security (/AS1) User’s Manual 05EN
Describes how to use the advanced security function
(/AS1 option).

DX1000/DX1000N/DX2000

Communication Interface User’s Manual
Describes how to use the communication functions using the
Ethernet and serial interfaces.

IM 04L41B01-17E

DX1000/DX1000N/DX2000
PLC Communication Protocol

IM 04L41B01-18E

Communication Interface User’s Manual
Describes how to use communication functions through the
PLC communication protocol interface.

DX1000/DX1000N/DX2000 IM 04L41B01-19E

PROFIBUS-DP (/CP1) Communication Interface User’s Manual
Describes how to use communication functions through the
PROFIBUS-DP interface (/CP1 option).

The electronic manual (CD, part no. B8706ZZ) is available for

purchase. Please contact your nearest YOKOGAWA dealer for
details.

DAQSTANDARD Manuals
Manual Title Manual No.”
DAQSTANDARD Viewer User’s Manual IM 04L41B01-63EN
DAQSTANDARD Hardware Configurator ~ IM 04L41B01-64EN
User’s Manual

DAQSTANDARD DX-P Hardware
Configurator User’s Manual
Installing DAQSTANDARD

IM 04L41B01-65EN

IM 04L41B01-66EN

General Specifications (GS)

General Specifications Name General Specifications No.”

Dagstation DXAdvanced GS 04L41B01-01E
DX1000

Dagstation DXAdvanced GS 04L43B01-01E

DX1000N

* The last characters, "EN" for example, of the manual number
and general specifications number indicates the language in
which the manual is written.

Notes

» The contents of this manual are subject to change without prior
notice as a result of continuing improvements to the instrument’s
performance and functions.

» Every effort has been made in the preparation of this manual to
ensure the accuracy of its contents. However, should you have
any questions or find any errors, please contact your nearest
YOKOGAWA dealer.

» Copying or reproducing all or any part of the contents of this
manual without YOKOGAWA's permission is strictly prohibited.

* This manual is part of this product. Keep this manual on safe
place for future reference.

+ The TCP/IP software of this product and the document
concerning the TCP/IP software have been developed/created
by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the
University of California.

Authorised Representative in the EEA and the

Importer into the EU/EEA Market
The Authorised Representative for this product in the EEA and the
importer for this product into the EU/EEA market via Yokogawa sale
channel is:

Yokogawa Europe B.V.

Euroweg 2, 3825 HD Amersfoort, The Netherlands

Importer for This Product into the Great Britain

Market
In relation to UKCA marking, the importer for this product into the
Great Britain market via the YOKOGAWA sales channel is :
Yokogawa United Kingdom Limited
Stuart Road Manor Park Runcorn, WA7 1TR, United Kingdom

QR Code

The product has a QR Code pasted for efficient plant maintenance
work and asset information management.

It enables confirming the specifications of purchased products and
user’s manuals.

For more details, please refer to the following URL.
https://lwww.yokogawa.com/qr-code

QR Code is a registered trademark of DENSO WAVE
INCORPORATED.

15th Edition: August 2023 (YK)
All Rights Reserved, Copyright © 2005, Yokogawa Electric Corporation
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Trademarks

+ DAQSTATION, Dagstation, and DXAdvanced are registered
trademarks of Yokogawa Electric Corporation.

* Microsoft and Windows are registered trademarks or trademarks
of Microsoft Corporation in the United States and/or other
countries.

» Adobe and Acrobat are registered trademarks or trademarks of
Adobe Systems Incorporated.

« Kerberos is a trademark of the Massachusetts Institute of
Technology (MIT).

« Company and product names that appear in this manual are
registered trademarks or trademarks of their respective holders.

* The company and product names used in this manual are not
accompanied by the registered trademark or trademark symbols
(®and ™).

Revisions

1st Edition: December 2005 2nd Edition: October 2006
3rd Edition: April 2007 4th Edition: December 2007
5th Edition: November 2008 6th Edition: March 2010

7th Edition: December 2010 8th Edition  March 2016

9th Edition: October 2016 10th Edition June 2018

11th Edition: May 2019 12th Edition June 2020

13th Edition December 2020 14th Edition October 2022
15th Edition August 2023

Safety Precautions

+ This instrument conforms to |IEC safety class | (provided with
terminal for protective grounding), Overvoltage Category Il or |,
Pollustion Degree 2, and Measurement Category Il (CAT Il).

+ This instrument is an EN 61326-1 (EMC standard) class A
instrument (for use in commercial, industrial, or business
environments). The influence rate (judgment condition A) in the
immunity test environment is within £10 % of the range or +10
mV (50V range only, +20 % of the range).

» When the voltage beyond the test voltage of the static electrostatic
discharge (direct contact 4 KV and air gap 8 KV) prescribed
by EN61326 was impressed on a front operating panel of this
equipment, there is a fear that equipment breaks down.

» The general safety precautions described here must be
observed during all phases of operation. If the DX is used in a
manner not described in this manual, the DX safety features may
be impaired. Yokogawa Electric Corporation assumes no liability
for the customer’s failure to comply with these requirements.

* The DX is designed for indoor use.

» Safety and EMC Standards

CSA: CAN/CSA-C22.2 No. 61010-1,

CAN/CSA-C22.2 No. 61010-2-030
Overvoltage Category Il or I"", Pollution Degree 27
Measurement Category s
UL:  UL61010-1, UL 61010-2-030 (CSA NRTL/C)
Overvoltage Category Il or I, Pollution Degree 27
Measurement Category s

CE, UKCA:
EMC directive:
EN 61326-1 Class A Table 2 (For use in industrial locations)
compliant,
EN 61000-3-2 compliant, EN IEC 61000-3-2 compliant,
EN 61000-3-3 compliant,
EN 55011 Class A, Group 1 compliant
Low voltage directive:
EN 61010-1, EN IEC 61010-2-030 compliant
Overvoltage Category Il or I'", Pollution Degree 27
Measurement Category Il
EU RoHS directive: EN IEC 63000 compliant

WEEE directive: Compliant

EMC Regulatory Arrangement in Australia and New Zealand (RCM):
EN 55011 Class A, Group 1 compliant

KC marking: KS C9811, KS C9610-6-2 compliant

*1 Overvoltage Category
Describes a number which defines a transient overvoltage
condition. It implies the regulation for impulse withstand voltage.
Applies to electrical equipment which is supplied from fixed
installations like distribution boards.
1I: Applied to standard power supply (100 - 240 VAC)
I: Applied to /P1 option (24 VDC/AC)
*2 Pollution Degree
Describes the degree to which a solid, liquid, or gas which
deteriorates dielectric strength or surface resistivity is adhering.
“2” applies to normal indoor atmosphere.
Normally, only non-conductive pollution occurs.
*3 Measurement Category Il
Applies to measuring circuits connected to low voltage
installation, and electrical instruments supplied with power from
fixed equipment such as electric switchboards.
About This Manual
* Please pass this manual to the end user. We also ask you to
store this manual in a safe place.
Read this manual thoroughly and have a clear understanding of
the product before operation.
This manual explains the functions of the product. It does not
guarantee that the product will suit a particular purpose of the
user.
Precautions Related to the Protection, Safety, and Alteration
of the Product
The following safety symbols are used on the product and in this
manual.

.

“Handle with care.” To avoid injury and damage to
the instrument, the operator must refer to the
explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal
as a protective ground terminal.)

Alternating current

| 0+ >

= = m Direct current

ON (power)

OFF (power)

O

« For the protection and safe use of the product and the system in
which this product is incorporated, be sure to follow the instructions
and precautions on safety that are stated in this manual whenever
you handle the product. Take special note that if you handle the
product in a manner that violates these instructions, the protection
functionality of the product may be damaged or impaired. In such
cases, YOKOGAWA does not guarantee the quality, performance,
function, and safety of product.

« When installing protection and/or safety circuits such as lightning
protection devices and equipment for the product and control
system or designing or installing separate protection and/or safety
circuits for fool-proof design and fail-safe design of the processes
and lines that use the product and the control system, the user
should implement these using additional devices and equipment.

« If you are replacing parts or consumable items of the product,
make sure to use parts specified by YOKOGAWA.

IM 04L41B01-02E



This product is not designed or manufactured to be used in
critical applications that directly affect or threaten human lives.
Such applications include nuclear power equipment, devices
using radioactivity, railway facilities, aviation equipment, air
navigation facilities, aviation facilities, and medical equipment.
If so used, it is the user’s responsibility to include in the system
additional equipment and devices that ensure personnel safety.
Do not modify this product.

A\

WARNING

Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power
supply before turning ON the power. In the case of a desktop
type, ensure that it is within the maximum rated voltage range of
the provided power cord before connecting the power cord.

Use the Correct Power Cord and Plug (Desktop Type)

To prevent electric shock or fire, be sure to use the power cord
supplied by YOKOGAWA. The main power plug must be plugged
into an outlet with a protective earth terminal. Do not disable this
protection by using an extension cord without protective earth
grounding.

The power cord is designed for use with this instrument. Do not
use the power cord with other instruments.

Connect the Protective Grounding Terminal

Make sure to connect the protective grounding to prevent
electric shock before turning ON the power.

The power cord that comes with the desktop type is a three-
prong type power cord. Connect the power cord to a properly
grounded three-prong outlet.

Do Not Impair the Protective Grounding

Never cut off the internal or external protective grounding wire or
disconnect the wiring of the protective grounding terminal. Doing
so invalidates the protective functions of the instrument and
poses a potential shock hazard.

Do Not Operate with Defective Protective Grounding

Do not operate the instrument if the protective grounding might
be defective. Also, make sure to check them before operation.
Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable
liquids or vapors. Operation in such an environment constitutes
a safety hazard.

Prolonged use in a highly dense corrosive gas (H2S, SOx, etc.)
will cause a malfunction.

Do Not Remove Covers

The cover should be removed by YOKOGAWA's qualified
personnel only. Opening the cover is dangerous, because some
areas inside the instrument have high voltages.

Ground the Instrument before Making External Connections
Connect the protective grounding before connecting to the item
under measurement or control unit.

Damage to the Protection

Operating the instrument in a manner not described in this
manual may damage the instrument’s protection.

AN

CAUTION

This instrument is a Class A product. Operation of this instrument
in a residential area may cause radio interference, in which case
the user is required to take appropriate measures to correct the
interference.

* Exemption from Responsibility

YOKOGAWA makes no warranties regarding the product except
those stated in the WARRANTY that is provided separately.
YOKOGAWA assumes no liability to any party for any loss

or damage, direct or indirect, caused by the user or any
unpredictable defect of the product.

¢ Handling Precautions of the Software

YOKOGAWA makes no warranties regarding the software
accompanying this product except those stated in the
WARRANTY that is provided separately.

Use the software on a single PC.

You must purchase another copy of the software, if you are to
use the software on another PC.

Copying the software for any purposes other than backup is
strictly prohibited.

Please store the original media containing the software in a safe place.
Reverse engineering, such as decompiling of the software, is
strictly prohibited.

No portion of the software supplied by YOKOGAWA may be
transferred, exchanged, or sublet or leased for use by any third
party without prior permission by YOKOGAWA.

Handling Precautions of the DX

Use care when cleaning this instrument, especially its plastic
parts. Use a soft dry cloth. Do not use organic solvents, such

as benzene or thinner, or other cleansers. They may cause
discoloring and deformation.

Keep electrically charged objects away from the signal terminals.
If you do, the DX may malfunction.

Do not apply volatile chemicals to the display, panel keys, etc.
Do not allow rubber and vinyl products to remain in contact

with the DX for long periods of time. If you do, the DX may
malfunction.

When not in use, make sure to turn OFF the power switch.

If there are any symptoms of trouble such as strange odors or
smoke coming from the DX, immediately turn OFF the power
switch and the power supply source. Then, contact your nearest
YOKOGAWA dealer.

Handling Precautions of the External Storage
Medium (CF Card)

Use caution in the handling of the external storage medium as it
is a delicate product.

Write operation to storage media may fail under high-temperature
or low-temperature environments. If you are using the DX in a low-
temperature environment (around 10 °C or less), use the DX after
the warm-up time (at least 30 minutes) has elapsed. If you are
using the DX under a high-temperature environment (around 40
°C or more), it is recommended that the external storage medium
be inserted into the drive when saving the data and be removed
after the data storage operation is finished.

Remove the storage medium from the drive when turning the DX
ON/OFF.

Touching the compact flash section when static electricity is built
up on the human body can lead to erroneous operation.

For the general handling precautions of the external storage
medium, see the instruction manual that came with the external
storage medium.

CAUTION

Do not eject the external storage medium while the access
indicator is illuminated. This can damage the data.

Do not access the storage medium in a place with vibrations or
shock. The storage medium or drive may malfunction.
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Checking the Contents of the Package
Unpack the box and check the contents before operating the
instrument. If some of the contents are not correct or missing or
if there is physical damage, contact the dealer from which you
purchased them.

DX

A name plate is located on the top panel of the DX (side panel on
models with the /H5[ ] option). Check that the model name and
suffix code given on the name plate match those on your order.

ame plate

NO. (Instrument Number)
When contacting the dealer from which you purchased the
instrument, please give them the instrument number.

MODEL and SUFFIX Code

Model code |Suffix code Oggggal Description
DX1002 Dagstation DX1000 2ch, 125ms (25ms*10)
DX1004 Dagstation DX1000 4ch, 125ms (25ms”10)
DX1006 Dagstation DX1000 6ch, 1s (125ms”10)
DX1012 Dagstation DX1000 12ch, 1s (125ms*10)
DX1002N"9 Dagstation DX1000N 2ch, 125ms (25ms*10)
DX1004N*9 Dagstation DX1000N 4ch, 125ms (25ms*10)
DX1006N"? Dagstation DX1000N 6ch, 1s (125ms”10)
DX1012N"® Dagstation DX1000N 12ch, 1s (125ms10)
Internal memory -3 Standard Memory (400 MB)
size
External storage medium | -4 CF card (with medium)
|Language 2 English/German/French, deg F, and DST
Options A1 Alarm output 2 points”!

A2 Alarm output 4 points™

/A3 Alarm output 6 points™"2

Ic2 RS-232 interface™

/Cc3 RS-422/485 interface™

[F1 FAIL/Status output2

IH2 Clamped input terminal (detachable

|/H5[] | Desktop type*4

M1 Math ical functions

IN1 Cu10, Cu25 RTD input/3 leg isolated RTD |

IN2 3 leg isol i RTD*S

IN3 Extended input type (PR40-20, JPt50, etc.)

[P1 24 VDC/AC power supply™

/R1 Remote control

/TPS2 | 24VDC transmitter power supply (2 loops)®

[TPS4 | 24VDC transmitter power supply (4 loops)7|
JUSB1__|USB interface

[PM1 Pulse input (including remote control and mathmatical functions)'
/cC1 Calibration correction function
/BT2 Multi batch fi ion™0

/CP1 PROFIBUS-DP"3

IAS1 Advanced security function

*1 /A1, /A2, /A3 cannot be specified together.

*2 /A3 and /F1 cannot be specified together.

*3 /C2,/C3, and /CP1 cannot be specified together.

*4 [H5[ ] can be specified for only DX1002, DX1004, DX1006, and DX1012.
D: Power cord UL, CSA st'd

F: Power cord VDE st’d
R: Power cord AS st'd
J: Power cord BS st'd
H: Power cord GB st'd

Null (/H5): Only for /P1 model (without power cord)

*5 /N2 can be specified for only DX1006, DX1006N, DX1012, and DX1012N.

*6 In case that /TPS2 is specified, /TPS4, /A2, /A3, or [F1 cannot be specified
together.

*7 In case that /TPS4 is specified, /TPS2, /A1, /A2, IA3, or [F1 cannot be
specified together.

*8 In case that /PM1 is specified, /A3, /M1, /R1, ITPS2, or /TPS4 cannot be
specified. And combination of /A2, /F1 cannot be specified together.

*9 DX1002N, DX1004N, DX1006N, and DX1012N are Pull Out Models.

*10 /BT2 can only be specified for the DX1006, DX1006N, DX1012, and DX1012N.

Standard Accessories
The standard accessories below are supplied with the instrument.
Check that all contents are present and undamaged.

5. One of these power cord types is supplied according
to the instrument’s suffix code.

No. Name Part Number/ Qty. Notes
Model
1 Mounting brackets B9900BX 2 For panel mounting
Except for the /H5[ ]
models.
2 Door lock key B8706FX 2 —

3 DX1000/DX1000N  IM 04L41B01-02E 1 A4 size
Operation Guide (this
manual)
Control of Pollution  IM 04L41B01-91C 1
Caused by the
Product
About the Usage IM 04L41B01-8121 1
of Open Source

Software
4 CF card B8706NQ 1 128 MB (The size and
model may change.)
5 Power cord A1006WD 1 Supplied only for

models with the /H5D
option. Maximum
rated voltage: 125 V
A1009WD 1 Supplied only for
models with the /H5F
option. Maximum
rated voltage: 250 V
A1024WD 1 Supplied only for
models with the /H5R
option. Maximum
rated voltage: 250 V
A1054WD 1 Supplied only for
models with the /H5J
option. Maximum
rated voltage: 250 V
A1064WD 1 Supplied only for
models with the /H5H
option. Maximum
rated voltage: 250 V
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Optional Accessories (Sold Separately)

The following optional accessories are available for purchase
separately. If you make an order, make sure that all contents

are present and undamaged. For information about ordering
accessories, contact the dealer from which you purchased the DX.

No. Name Model Minimum  Notes
Qty
1 CF card 772093 1 512 MB
772094 1 1GB
772095 1 2 GB
2 Shunt resistor 415920 1 250 Q +
0.1%
(for screw input terminal) 415921 1 1000+
0.1%
415922 1 10Q +0.1%
3 Shunt resistor 438920 1 250 Q +
(for clamped input 0.1%
terminal) 438921 1 100Q +
0.1%
438922 1 100 +0.1%
4 Mounting brackets B9900BX 2 -
5 Door lock key B8706FX 1 —
6 Remote control terminal 438227 1 Remote
controller.
7 Validation document - 1 Electronic file

Style number, release number, and firmware
version number of the DX

Style number: This is the DX hardware number that is indicated
on the name plate.

Release number: This is the DX firmware number that is indicated
on the name plate. The number corresponds to
the integer part of the firmware version number.

Example: If the firmware version number is 2.01, the release

number is 2.

Firmware version number: This number is displayed on the DX
system information screen. For the procedure,
see section 2.5, “Viewing the DX Information”
in the DX71000/DX1000N User’s Manual (IM
04L41B01-01E).

— Release number
— Style number

Protection of Environment

Control of Pollution Caused by the Product

For details, see the Control of Pollution Caused by the Product
(IM04L41B01-91C).

Proper Disposal of This Product
This is an explanation of how to dispose of this product based on
Waste Electrical and Electronic Equipment (WEEE), Directive and
Regulation. Only valid in the EEA for EU WEEE Directive and in
the UK for UK WEEE Regulation.
» Marking
This product complies with the WEEE marking requirement.
This marking indicates that you must not discard this electrical/
electronic product in domestic household waste.
When disposing of products in the EEA or UK, contact your local
Yokogawa office in the EEA or UK respectively.

2

How to Replace and/or Dispose the Batteries
This is an explanation about the EU Battery Directive/Regulation
and UK Battery Regulation.
Only valid in the EEA for EU Battery Directive/Regulation and in the
UK for UK Batter Regulation.
Batteries are included in this product. Batteries incorporated
into this product cannot be removed by yourself. Dispose them
together with this product. When you dispose this product in the
EEA or UK, contact your local Yokogawa office in the EEA or UK
respectively. Do not dispose them as domestic household waste.
Battery type: Lithium battery

Notice: The symbol (see above) means they shall be sorted out
and collected as ordained in the EU Battery Directive/Regulation
and UK Battery Regulation.
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Conventions Used in This Manual

* This manual covers information regarding DX1000/DX1000Ns
that have a suffix code for language “-2” (English).

» For details on how to set the language, see section 2.6,
“Changing the Language” in the DX71000/DX1000N User’s
Manual (IM 04L41B01-01E).

Unit

K: Denotes 1024. Example: 768 KB (file size)
k: Denotes 1000.

The following markings are used in this manual.

Improper handling or use can lead to injury to the user or damage
to the instrument. This symbol appears on the instrument to
indicate that the user must refer to the user’s manual for special
instructions. The same symbol appears in the corresponding place
in the user’s manual to identify those instructions. In the manual,
the symbol is used in conjunction with the word “WARNING” or

“CAUTION.”

Calls attention to actions or conditions that could cause serious or
fatal injury to the user, and precautions that can be taken to prevent
such occurrences.

CAUTION

Calls attentions to actions or conditions that could cause light
injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Note
Calls attention to information that is important for proper operation
of the instrument.

>

Indicates after this mark reference to related procedure or
explanation.

Bold characters
Indicates character strings that appear on the screen and the
operation keys.

Revision History

The contents of this manual corresponds to the DX1000 with release
number 4 and style number 5, and the DX1000N with release
number 4 and style number 5. For details on the functions that
have been added or changed, see “DX’s Version and Functions
Described in This Manual” in the DX7000/DX1000N User’s Manual
(IM04L41B01-01E).

Edition DX Description

2 Version 1.11 Additions and improvements to
Version 1.21 functionality.

3 Release number 2 Additions and improvements to
(Version 2.0x) functionality.
Style number 2 NEMA4 compliance.

4 Same as edition 3 Additions and improvements to
functionality.

Changed the direction of the
clamp input terminal (/H2 option).

5 Release number 3 Additions and improvements to

(Version 3.0x) functionality.
Style number 3 Changed the boot ROM.
6 Release number 4 Additions and improvements to
(version 4.0x) functionality. Internal memory
Style number 3 suffix code -3 has been added,
and -1 and -2 have been removed.

7 Same as edition 6 Additions and improvements to
explanations.

8 Release number 4 Additions and improvements to

(version 4.0x) explanations. NLF is supported.
User’s manuals are supplied by
downloading them on the web
site.

Style number DX1000: A 5.7-inch LCD with LED

DX1000: 4 back light replaced a 5.5-inch LCD

9 Same as edition 8 Merge the manuals (IM
04L41B01-91C, IM 04L41B01-
81Z1).

10 Same as edition 9 Changes of "Proper Disposal of
This Product”

1 Same as edition 10  [Delete the CF card adapter.
Changed the battery assembly
part number.

12 Release number 4 Changed the style (H).

(version 4.2x) Changed the EtherNet/IP name.

Style number

DX1000: 5

DX1000N: 5

13 Same as edition 12 Corrections (delete the tolerance
of external dimensions).

14 Same as edition 12 |Correspodence to UKCA.

15 Same as edition 12 Correspodence to EN standards.
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Introduction to Functions

Measured Items
You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure

various values such as temperature and flow rate. The DX samples the input signals at
the scan interval to obtain the measured values. The fastest scan interval is 25 ms on
the DX1002, DX1002N, DX1004, and DX1004N and 125 ms on the DX1006, DX1006N,
DX1012, and DX1012N.

Up to four alarm conditions can be set for each measurement channel.

Data Storage Function
There are two methods of recording measured data. One is to record the measured data

continuously, and the other is to record only when certain events occur such as alarms.
The measured data is recorded to the internal memory at a specified interval. The data in
the internal memory can be stored to a CF card automatically or manually. By connecting
to a network via the Ethernet interface, the measured data can also be automatically
transferred to an FTP server on a network.

Automatic data transfer to an FTP server

Ethernet
DX I|—; E FTP server

/\/ » D/\(um ernaI{em <> @cnard

Measurement input

Display Function

Measured data can be displayed as trends, numeric values, and bar graphs for each
group. In addition, the overview display can be used to display and monitor all channels
on a single screen.

Trend display Numerlc (dlgltal) dlsplay Bar graph dlsplay Overview dlsplay

3 {7 165 19 115 3 73 65 TB 'm 68 dl

Other Functions

Computation Function (option) Various types of computation can be performed by
assigning equations to computation channels.

FAIL/status output function (option) Outputs an alarm when the DX fails. The function
also monitors the DX status such as the remaining
amount of internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the
DX. The function can also be used to prohibit key
operation.

Communication function The Ethernet interface can be used to monitor the

DX using a Web browser and transmit e-mail when
an event occurs such as an alarm. In addition,
data of devices on the network can be loaded and
displayed using the Modbus protocol.

DAQSTANDARD
The software program, DAQSTANDARD, can be used to display the measured data,

convert the measured data format, and create DX setup data.

IM 04L41B01-02E 9



Introduction to Functions

DX System Configuration

The DX can be used to configure a system as shown below.
Referenced sections are of the DX71000/DX1000N User’s Manual.
Referenced pages are of this manual.

.. === PLC (programmable
P Communication Interface User’s Manual g PC logic controller)
So

PLC Communication Protocol Communication Interface
User’s Manual
PROFIBUS-DP Communication Interface User’s Manual

PLC corﬂ_munication

Ethernet protoco

Temperature Recorder

a | controller

PLC

Serial
communication* A\

/'RS-232, RS-422/485, or PROFIBUS-DP't

{ - J-E Signal input

Remote Terminal”
p Sec.2.10

FAIlL/status output”
P Sec. 2.9

pSec. 3.3
» @ CF card
P Page 24
Pulse input" » DX
P>Sec. 3.10 | | N USB flash memory
USB port P Sec. 2.12
Transmitter power supply” «
P Page 58 SRS Keyboard
‘ = ‘ R p Sec. 2.11
S~ j——
Alarm output* « D@ Keys @\ Barcode reader't
» Sec. 3.5-3.8 L P> Sec. 2.11

Remote input”

*s Option > Sec. 7.1

1: Release number 3 or later

Terminology
* Memory sample

The operation of recording measured data.
* Memory start
The operation of starting memory sampling.
* Memory stop
The operation of stopping memory sampling.
* Display data
The waveform data shown on the DX display. The data recorded at the sampling
interval for the displayed data.
* Event data
Measured data recorded at a sampling interval separate from that of the display data.

10 IM 04L41B01-02E



Names of Parts

Front View

Key panel opened

Power indicator
llluminates in red when the
power is turned ON. llluminates

LCD

Display various operation displays
such as the trend display as well as
setup displays.

B

Front cover (key panel)

Open the front cover by pulling the
cover while holding down the tab at
the center of the upper section of the
cover.

YOKOGAWA ¢
i _ A ) N
OOOOOD ‘\\
e

CAUTION

in green while memory
sampling is in progress.

Remote control sensor
(/KB1 and /KB2 options)
Receives infrared light from the
remote control terminal.

Label (front of the key panel cover)
Write arbitrary labels for your
convenience.

Jb'z'l

Key panel cover
Open the cover by pinching the
left tab and pulling forward.

Front cover opened

YOKOGAWA ¢

When closing the front cover, press
the front cover in until the tab at the
center of the upper section of the
cover is all the way up. If the front
cover is not closed completely, the
water and dust proof capability may
be impaired.

USB port
A USB port conforming to Rev.
1.1.

CF card slot

—

Power switch
Not available on the DX1002N,
DX1004N, DX1006N, and
DX1012N.

—t—0® |g)

— CF card access indicator

CF card eject button
Used when ejecting the CF card.

Door lock key (included)
Insert the pin in the left hole to lock.

Insert the pin in the right hole to unlock.

IM 04L41B01-02E
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Names of Parts

Rear Panel

USB port (/USB1 option)
A USB Rev. 1.1 compliant port.

Ethernet port

Serial port
(/C3 option)
RS-422/485 port.

— Power supply terminals

PROFIBUS-DP port
(/CP1 option)

S
? PROFIBUS connector.

A 10Base-T port.

@ Serial port
o fH o | Y (/C2 option)
ofcaje [ RS-232 port.

@

Desktop Type (/H5[ ] Option)

Handle

L Feet and Stand

Optional terminals (/A[ ], /F1, IR1,
ITPS[ ], and /PM1 options)

Used to connect optional
input/output signal wires.

Input terminals (screw
terminals or clamped
terminals; /H2 option)

Used to connect input signal.

Functional ground
terminal

Power

connector

12
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DX1000/DX1000N Workflow

Installation

Wiring

At

FERLNG)

Power ON

Environmental
Settings

Functional
Settings

A

Measurement

1]
U

Data
Management

CF Card
Insertion

User
Registration

i

Environmental
Settings

o

Functional
Settings

Measurement

RRSRE R

WL

Data
Management

When using the DX for the first time, carry out the following procedure.

Install the DX.
> Page 49 and subsequent pages

Connect input/output wires to the terminals and connectors on the
rear panel, and connect the power cord.
> Page 52 and subsequent pages

Turn the power ON. (DX1002, DX1004, DX1006, and DX1012 Only)
» Page 13

Set the date/time, load the CF card, and so on.
P Page 18 and 24

Set measurement functions.
P Page 19 and subsequent page, page 28 and subsequent pages

Start the measurement. Perform operations such as switching the
screen and writing messages. Save the measured data.
P Page 39 and subsequent pages

Check and manage the measured data.

Use the software program, DAQSTANDARD, to display

the measured data and convert the measured data to Excel, Lotus, and
ASCII formats.

» Page 48

» DAQSTANDARD Viewer User's manual (IM 04L41B01-63EN)

On a DX with advanced security (/AS1 option; release number 4 or later), carry out the
following procedure after turning the DX on.

Insert a CF card into the DX.
» Page 24

Register the users who will operate the DX.
P Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)

Set the date/time.
p Page 18

Set measurement functions.
P Page 19 and subsequent pages, page 28 and subsequent pages

Start the measurement. Perform operations such as switching

the screen and writing messages. Save the measured data.

P Page 39 and subsequent pages

Check the measured data, and attach approval information

to the measured data file.

p Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)

You can also attach approval information to the measured data file
by using the software program, DAQSTANDARD.

p DAQSTANDARD Viewer User’s Manual (IM 04L41B01-63EN)

IM 04L41B01-02E
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Turning the Power ON/OFF (px1002, bx1004, DX1006, and DX1012 Only)

Turning the Power ON

A CAUTION

Before turning ON the power switch, check that

» The power cord/wires are connected correctly to the DX.

« The DX is connected to the correct power supply (see page 60).

If the input wires are connected in parallel with other devices, do not turn ON/OFF
the power switch of the DX or another device during operation. This can have
adverse effects on the measured values.

Open the operation cover.

2. Turn ON the power switch.
After performing a self-test for a few seconds, the operation screen appears.

3. Close the operation cover.

A CAUTION

« If nothing is displayed when the power switch is turned ON, turn OFF the
power switch and check the points listed above one more time. After checking
the points, turn ON the power switch again. If the DX still does not work, it is
probably a malfunction. Contact your nearest YOKOGAWA dealer for repairs.

» If an error message is displayed on the screen, take measures according to the
description in chapter 10, “Troubleshooting” in the DX71000/DX1000N User’s
Manual.

» Turn ON the power switch, let the DX warm up for at least 30 minutes, and then
start the measurements.

Turning the Power OFF

A CAUTION

Before turning OFF the power switch, check that the external storage medium is
not being accessed.

1. Open the operation cover.
2. Turn OFF the power switch.

3. Close the operation cover.

14 IM 04L41B01-02E



Basic Operation

Panel Keys

YOKOGAWA ¢

® LCD

Key panel

DISP/ENTER key and four arrow
keys (up, down, left, and right)
Switches the operation screen.
Soft keys Selects and enters setup items.
f—%

Selects the menu that is displayed
at the bottom of the screen.

OO
@ @SERDFUN@ @ssc DMEN:U)) @ ‘&

DISP/ENTER key

Up arrow key

Right arrow key

Down arrow key
\T Left arrow key
START/STOP key Favorite key
Memory start/stop. ESC key Displays the operation screen (up to eight
Cancels an screens) that are registered to the key.
operation. MENU K
USER key oL ey ,
Executes the assigned Swgchesdbet\;\t/_een th?j operation
operation. mode and setting mode.
FUNC key

« Displays the soft key menu in operation mode.
» Hold down this key at least 3 s in the setting mode to switch from the
setting mode to the basic setting mode.

Status display section
| Shows the display name, date/time, data recording, alarm
icon, etc.

Imin/diy

14:33

o— Waveform | Data display section

display [ Shows the measured data and the functional setup.
14231 For displaying the scale, see section 5.7, in the
. DX1000/DX1000N User’s Manual (IM 04L41B01-01E).
®—Numeric | Fq gisplaying the waveform and numeric dispay, see
display | gection 4.2, in the DX7000/DX1000N User’s Manual (IM
J 04L41B01-01E).

IM 04L41B01-02E 15



Basic Operation

Display on the Status Display Section

The following information is displayed in the status display section.

Memory sampling status

. Data type
Memory sampling |22 i
] A DISP: Display data

EVENT: Event data
’ﬁ Memory sampling
Memory sampling ||¢."”

in progress

Memory sampling icon

X

Displays

progress

Displays the progress using a green bar graph. The frame indicates the file
save interval (display data) or the data length (event data).

Error in internal memory.
Contact your nearest YOKOGAWA dealer for repairs.

the remaining memory sampling time for the left bar graph.

Display name or group name

For all channel display on the trend display, “All” is
displayed.

Date and time

Displayed in yellow while the time is being corrected.

When using the batch function
AAA-123d-ABR5d ]

Batch name and the display!
name are shown alternately.,
Date and time

‘a1 14:21:26

If the “batch number-lot number” exceeds 20 characters,
the “date and time” position is used to display the “batch
number-lot number.”

When using the login function

display nhame are shown
alternately.

the login and batch functions

Name of the user logged in
Batch name, the display
name, and date and time are
shown alternately.

The green level display indicates the amount ———————|

of CF card used. If Media FIFO* is not enabled

and the free space on the CF card falls below

10%, the level indicator changes to red.

* See section 1.4, in the DX71000/DX1000N User’s
Manual. Media FIFO is a function available on
release number 2 or later.

B

Alarm icon

Displayed when any alarm is activated.
“}} Blinks when there are alarms that are

(Red) occurring but have not been acknowledged.

All alarms have been released after they
have occurred, but there are alarms that
(Green) have not been acknowledged.

status icon
The status assigned to the status output
(/F1 option) is occurring.

User Locked Icon (/AS1 option)
Displayed when the user is locked.

m Keys are locked.

E E-mail transmission is enabled.

——Computation icon (/M1 or /PM1 option)
+=
-t
+=
-
L— CF card icon

o)
&
S

White icon: Computation started.

Yellow icon: Computation data dropout occurred.

CF card is being accessed.

Waiting.

Light blue icon: CF card in the slot is not
recognized. Remove and reset it.

*

CF card error.

Carry out the procedure below to reset the CF

card icon to normal.

» Remove the CF card, and then reinsert it.

* Replace the CF card with a normal one.

» Format the CF card on the DX (the data on
the CF card will be erased).

16
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Basic Operation

Run Modes

Mode Transition Diagram

Power ON

'

Operation mode

Setting mode

End menu > DISP/ENTER or
ESC > DISP/ENTER
(release number 3 or later)

MENU key

MENU key
or ESC key

€---=--=--

On a DX with advanced security

(/AS1 option; release number 4 or later):
MENU key or ESC key > DISP/ENTER
or

End menu > DISP/ENTER

DIS|
key

Alarn

'i

Date/Tine

Basic setting mode

>
Heas channel >
Hath charmel >

Displa: r

Grow Setting menu
nesson___display

Timer, Ewvent action »

Data save »

Henu customize >
Basic setting mode

T
P/ENTER MENU key

or ESC key

r="Tom
o1 10:17:04 B0 IECT(O)
~CH [ Last-cH

Ranse  Span_L

Span_Ul
2 [-2.6000 | 2.0008

Setup display

a1
Range
Hode

Valt

1
2
3
4

+

Hold down FUNC
for3sor

Basic Setting Mode
> DISP/ENTER
(release number 3
or later)

Basic Setting Hode i
Envirorment | ICTVINN|F ile/Initial ize|
Alarn »

#/D, Henory
Burnout, RIC

Report - -
Tine oo Basic setting
Connunid menu display
Status relas

End

I
DISP/ENTER

1 ESC key

The DX has three modes.

key

Scan interval
Scan nods

Scan interval is
A/D intearate

Hemory

== 4" Setup display

w

Mode

Description

Operation mode

A mode for performing measurements.

Setting mode

A mode in which input range, measurement method, and so on
are configured. Settings can be changed when memory sampling
is in progress excluding some items.

Basic setting mode

A mode used to set basic items such as the scan interval and
storage format of measured data. On a DX with advanced
security (/AS1 option; release number 4 or later), the login
settings can be changed during memory sampling.

* For further details on the basic setting mode and setting mode, see page 63.

Carry out the steps given in the following pages. It will help you to understand the DX

operation.

IM 04L41B01-02E
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Basic Operation

Entering Values and Characters
The character/number input window and DISP/ENTER key are used to set the date/time,

set the display span of the input range, set the tag, set the message string, enter the
password, etc.

Character/number input window DISP/ENTER key and four arrow

Cursor keys (up, down, left, and right)

Text box for entering
the character string

——— Select the character.
(keypad)

Input status of the A/a/1 soft key
——— Input status of the Ins soft key

lELeft and right

arrow soft keys
Number input window

F'Q'wﬂ Press the up arrow key to increase the number.
f“"- Press the down arrow key to decrease the number.
Press the left and right arrow keys to move the cursor
to the appropriate input position.

Entering Character Strings
When a window for entering a character string appears, enter it by performing the

following key operation.
» Left and right arrow soft keys: Moves the cursor in the text box to select the input
position.

* Keypad: Use the four arrow keys (up, down, left, and right) to move the
cursor on the keypad to select the desired character.
Ins: Switches between insert and overwrite.
Del: Deletes the character at the cursor position in the text box.
ENT: Enters the character string in the text box.

DISP/ENTER key: Enter the character that you selected with the keypad in the text
box or execute Ins, Del, or ENT.

* Bs soft key: Backspace. Deletes the character before the cursor.

Alal1 soft key: Selects uppercase alphabet (A), lowercase alphabet (a), or value
(1).
The character type that you can enter changes each time
you press the Alal1 soft key. The selected character type is
displayed at the bottom section of the character/number input
window.

18 IM 04L41B01-02E



Basic Operation

The contents of the screens in the operation examples below may change depending on
which options are installed and how the settings are configured.

On a DX with advanced security (/AS1 option; release number 4 or later) you must first
insert the CF card into the slot (see page 24).

Changing the Date/Time

In this example, we will change the date from the 1st to the 6th. After carrying out this
step, reset the time to the correct date/time.

1. Display the operation mode screen.

2. Press MENU once to display the setting menu.

3. Press the down arrow key once.
The cursor moves to Date/Time.

4. Press the right arrow key once.

Heas channel Dawlight Saving Time

Hath channel
Display

[} Tine

»
»

Group zet. Trip line

Hessage, Comment Text

Timer, Event action
Data save

Henu customize
Bazic setting mode

»
»
»
»

— Select Date & Time.

5. Press DISP/ENTER once to open the Time set window.

6. Change the date from 01 to 06.
Select the input position:

Enter the value:
Enter the input:
Cancel the setting:

Date/Time

Heas channel

Hath channel

Dizpl:

Group

Hezsa: [ 4 |

Dawlight Saving Time

>

Timer| QR8/12/03 18:23:26 3
=a

Data
Henu o

Press the right arrow key five times to move the cursor in

the text box.

Press the up or down arrow key several times to display 6.
Press DISP/ENTER once.
Press ESC before pressing DISP/ENTER (entering the

input).

Bazic setting mode

Display the Time set window.
(Display after entering 6)

IM 04L41B01-02E
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Basic Operation

7. Press ESC twice or MENU once to return to the operation mode screen.
On a DX with advanced security (/AS1 option; release number 4 or later):

Press ESC twice or MENU once to display a confirmation screen. To return to the
operation mode screen, select Yes, and press DISP/ENTER once.
Operation complete.

Operation Example in the Setting Mode: Changing the Input Range

Type T
thermocouple  Channel 2

Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.
DX

<

0T a0

1. Display the operation mode screen.

B.8aeay
2. Press MENU once to display the setting menu.
3. Press the down arrow key twice to select Meas channel.

Press the right arrow key once.

Rahge. Alarm
Tag. Memorw. Delaw
Dizplay Hoving average

— Select the Range, Alarm.

Group set. Trip 1 Color

Hessage. Comment Zone. Scale
Timer. Event acti Bar ararh

Data save Alarm mark

Henu customize Color scale band

Basic setting moc Calibration correction

20
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Basic Operation

10.
1.

12,

13.

Press DISP/ENTER once.
b1 G- M (O

First-CH: Last-CH: ant
Range ®

Hode Range Span_L Span_ll
[Wo1t [ 2y [-2.eeee [ 2.eee8

Select First-CH.

Alarm

1 [oFF
2 [off
3 ff
¢ [orf

Input +1 -1

olo|o

Press the +1 soft key once to set First-CH and Last-CH to 2.
Press the down arrow key once to move the cursor to Mode.

Press the TC soft key once. The cursor moves to Range, and the changed item is
displayed in yellow.
' 51 Gggor (O]

B2  Last-CH: aaz2

Hode Range Span_L  Span_U

T?C a.8 [ 1768.8

Select TC.

Press the Next soft key.
Press the T soft key once. The cursor moves to Span_L.

Press the Input soft key once.

S0 I (O)
First-CH: 882 Last-CH: 802
Range
Hode Range Span_L Span_U
[Te [ 7 DEETN[ dvn.0
[ & | . . .
200.0[) & Display the Span_L setting window.
Alarm ]
1 [of
2 [of]
3 [of]
4 [off

Enter 0.0 in the Span Lower box.

Select the input position: Press the right arrow key once to move the cursor in the
text box to the right.

Delete the minus sign: Press the up arrow key once to delete the minus sign.

Delete the 2 and 0 in the same way.

Enter the input: Press DISP/ENTER once. Span_L is set, and the cursor
moves to Span_U.

Cancel the setting: Press ESC before pressing DISP/ENTER (entering the
input).

Enter 400.0 in the Span Upper box.

See step 12 for the procedure.
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Basic Operation

14. Press DISP/ENTER once. The changed items are entered, and the cursor returns
to First-CH. The changed items change from yellow to white.
Eﬁ?cm}-llmiiﬂl[:j
[EH Last-cH:

Range Span_L  Span_U
[ 1 ] A.8 | 4B,

o
oo
|
—+ |+

4 [oFF

Input +1 -1

15. Press ESC three times or MENU twice to return to the operation mode screen.
On a DX with advanced security (/AS1 option; release number 4 or later):

Press ESC three times or MENU twice to display a confirmation screen. To return
to the operation mode screen, select Yes, and press DISP/ENTER once.
Operation complete.
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Basic Operation

Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX1012

is changed to 2 s. The selectable scan intervals are different on the model, but the
procedure is the same.

Measures every 2 s T DX T
Type T
thermocouple  Channel 2
<
0
1. Display the operation mode screen.

0= T (S)

Iminddiy

DatesTime

Heas channel

Hath channel

Display

Group zet. Trip line
Hessage, Comment Text

v vww

Timer, Event action
Data save

Henu customize
Bazic setting mode

v vww

Hold down FUNC for at least 3 s.

Alternatively, you can execute the following procedure to switch to Basic Setting mode.
Use the up or down arrow key to select Basic setting mode on the Menu tab, and
press DISP/ENTER.

A confirmation window will appear. Select Yes, and press DISP/ENTER.

Basic Setting Hode

Envirorment | IMENTENINN File/Tnitislizel o—— pjsplay the Basic Setting Mode menu.
Alarm 3

A/D. Hemory

Burnout. RJG

Report 3

Tine settings

Conmunication (Ethernety »
Status relay

End

IM 04L41B01-02E
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4. Press the down arrow key twice to select A/D, Memory.
5. Press DISP/ENTER once.

Basic Setting Hode

Scan interval

Sean mode | tornal |
Scan interval 1s

A/D intearate Auto
Hemory

Data kind Dizsplay

Hormal

Press the down arrow key once to move the cursor to Scan interval.

Press the 2s soft key once. The cursor moves to A/D integrate, and the changed
item is displayed in yellow.
Cancel the setting: Press ESC before pressing DISP/ENTER.

Press DISP/ENTER once. The changed items are entered, and the cursor returns
to Scan mode.

Basic Setting Hode

Scan interval

Scan mode

Scan interval 2z _&———— Setthe scanintervalto 2 s.
A/D intearate Auto

Hemory

Data kind Dizsplay

Hormal

9. Press ESC once to return to the basic setting mode menu.
10. Press ESC once more.

Alternatively, use the up or down arrow key to select End, and press DISP/ENTER.
Basic Setting Hode e

Erwi ronment: ] Henu ]Fi]e!Initia]ize]

Alarm »

A/0, Hemory
Burnout. RJG

Display the confirmation window.

[ Mo [ cancel

11. Press DISP/ENTER once. The settings are saved, and the DX returns to the

operation mode screen.

Discard the changes: Select No and press DISP/ENTER.
Do not end the basic setting mode: Select Cancel and press DISP/ENTER.

Operation complete.
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Inserting/Removing a CF Card

Inserting a CF Card

Open the operation cover.

A CAUTION

Forcing the CF card into the slot with
the upside down may cause damage.

With the label “This side up”

\_facing up
Insert the CF card into the slot.
o 5 BEIVIF @ Displays the CF card icon

tnlnzdil try reinserting it.

Close the operation cover.

Operation complete.

Removing a CF Card
<Operations in the Operation Mode>

Press FUNC once.

2. Press the Media eject soft key once.

z P ] — .
RO Lt 10:2:1> S0 IEEEN(O) CF card icon

Iminddiy

18:21

Media eject

Press the CF soft key once. The message “Media can be removed safely”
appears. Displays the CF card icon in blue.

Open the operation cover.

If the DX does not recognize the CF card,

IM 04L41B01-02E
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6.

Press the CF card eject button. When you eject the CF card, the CF card icon
disappears.

~

Press the eject button in until it clicks.

The eject button stops at depressed position.
Pinch the left and right sides of the CF card
and remove it.

Eject button

Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>

1.

2,
3.
4,

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to
basic setting mode), select the File/lnitialize tab > Media eject > CF *, and press
DISP/ENTER.

Erwi ronment: ] Henu ]Fi]e;"Initia] ize]

Load settings
Initialize

Hedia eject

End

The message “Media can be removed safely” appears.
Open the operation cover.
Press the CF card eject button. Remove the CF card.

Close the operation cover.

Operation complete.

Note

If you remove the CF card without carrying out the media eject procedure, the message “Media
was removed compulsorily” appears. Remove the CF card by carrying out the procedure above
to prevent damaging the data that is stored.

26
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Saving the Setup Data

In this example, we will save the setup data to a file named “SF2” on the CF card.

1.

Display the operation mode screen.

Iminddiy

Press MENU once to display the setting menu.
Press the right arrow key once to select the File tab.

Press the down arrow key four times.

Henu ] File ]
Load display data
Load event data
Load settings

Save settings

@[ Select Save settings.
Custom display load » 9

Custom display save »
File list/delete
Format

Press DISP/ENTER once.
Press the Input soft key once.

Enter “SF2” for the file name.
For the input procedure, see “Entering Values and Characters” on page 17.

Press DISP/ENTER once. The message “Data are being saved to media”
appears, and the setup data is saved.

Press ESC or MENU twice to return to the operation mode screen.
On a DX with advanced security (/AS1 option; release number 4 or later):

Press ESC or MENU twice to display a confirmation screen. To return to the
operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.
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27



Basic Operation

Loading the Setup Data
In this example, we will load the setup data “SF2” from the CF card and update the DX

settings.

This procedure only loads the setup data that the DX uses for setting mode.To load the
setup data for both setting mode and basic setting mode, press MENU, hold down FUNC
for 3 s, select the File/lnitialize tab > Load settings, and press DISP/ENTER.

1.

Display the operation mode screen.
OUP 1 e
13/t 10.25:00 0 V(S

Iminddiy

B.0861v
Press MENU once to display the setting menu.
Press the right arrow key once to select the File tab.

Press the down arrow key three times.
" @0 T (S)

File |

Load display data
Load event data

|oad settings — Select Load settings.
Save settings

Custom display load »
Custom display save »
File list/delete

Format

Press DISP/ENTER once to select the root directory (CF:/).
Press DISP/ENTER once to display the files in the root directory.

Select the file SF2 using the up and down arrow keys.

Load settings

ke File name s 10 Move to a lower directory
— e 2 Select the directory, and press
- DISP/ENTER.

To move to a higher directory
Press ESC.

Free space 24554 Kbwtes

8. Press DISP/ENTER once. The message “File is being loaded from media”

appears, and the setup data is loaded. The DX automatically returns to the
operation mode screen.

Operation complete.
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

DX
\ \

Type T
thermocouple Channel 1

-
0.0 to 200.0°C d
Setup Item Description Number in the Figure
Channel Use channel 1. 1
Tag TI-001 2
Sensor Type T thermocouple 3
Input range 0.0 to 200.0°C 4

(1) Input Range
Press MENU (switch to the setting mode).

@ Last-CH:
? 1

Range Span_L  Span_U

[ 1 ] A.8 | 208.8
T 4
3
1 [off
2 [off
3 [off
4 [off
Input +1 =il
(2) Tag

Select the Menu tab > Meas channel > Tag, Memory, Delay.
3 =
| 19:54:10 SR (D)

First-cH: 0] Last-CH: BA1
Tag
Characters
f1-ma1 -2
Hemory sample
On/fOff On
Alarm delay
Time 18 =
Input +1 -1

Operation complete.
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Setting the Input Range and Alarm

Setup Example 2: Flow Rate Measurement Channel and Alarm
DX

Flowmeter Channel 2

4-20 mA
@-gz /D

Convert to 1-5 V with a shunt resistor

Setup Item Description Number in the Figure
Channel Use channel 2. 1
Tag FI1-002 2
Input signal 1-5V 3
Input range 0.0 to 500.0 L/H 4
Alarm condition Output an alarm if the measured valueis 5

less than or equal to 120.0 L/H.
Output destination: Relay contact (103)

(1) Input Range and Alarm
Press MENU (switch to the setting mode).

Select the Menu tab > Meas channel > Range, Alarm.

First-cH: Last-CH: BA2
Range T

Hode Range Span_L  Span_U 1
[1-Eve [1-5ve [ 1.@@@ [ 5. aoe
Scale_L Scale_ll Unit Low-cut 3
[ a.8 | SBB’.B |Lf,H 0ff
Alarm Type Walue Relay Mo, 4
1 On T 12%.8 Of 1%3
2 [off
[oFF 5
4 [off
Input +1 -1
(2) Tag
First-CH: [EH Last-cH: a8z
Tag
Characters
F1-pa2 2
Hemory sample
On/Off [on
Alarm delay
Time 18 =
Input +1 -1

Operation complete.
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Setting the Display

Setup Example 3: Assigning Channels to Groups

In this example, we will assign channels 1 and 2 to group 1.

F1-862
187.9 425.9
cl = L/H
Channel 1 Channel 2
Setup Item Description Number in the Figure
Group Assign channel 1 and 2 to group 1. 1
(1) Group

Press MENU (to switch to setting mode) > select the Menu tab > Group set, Trip
line.

[ =1
| 1111103 00 EEZYE(S) 0}

Group number 1
Group set
On/fOff On @
Group name GROUP 1
CH set BE1. 882 L —
Trip line
1 |off
2 |off
3 |off
4 |off
Input +1 -1

Operation complete.
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Setting the Display

Setup Example 4: Setting the Time Scale

Set the time per division of the trend waveform to 2 minutes.

The sampling interval (the time
corresponding to 1 dot) is 4 s when the trend
interval is 2 min.

30 dots x 4 s =2 min

Setup Item Description Number in the Figure
Trend interval Set the time per division to 2 minutes. 1

The waveform is updated at every 4 s.

(1) Trend interval

Press MENU (to switch to setting mode) > select the Menu tab > Display > Trend/
Save interval.

[ -]
| 610507 e (O] )

Trend / Save interval

Trend interval [/divl  [EILe—— 1
Save interval 1h

Imin 2min Smin 18min

Operation complete.
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Setting the Data Storage

Setup Example 5: Continuously Record Measured Data and Automatically Save
In this example, we will continuously record and save the measured data of channel 1
and 2.
For the procedure to set the channel, see “Setting the Input Range and Alarm” on page
28. For the procedure to set groups, see “Setting the Display” on page 30.

Automatically save to
the CF card periodically.

<>

F1-882
83.9 216.1
] LA

°C
+Channel 1 4 Channel 2
Setup Item Description Number in the Figure
Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1
Data to be recorded  Continuously record the display data from the start of the 2
measurement.
Data storage method  Automatically store every 24 hours. 3
Sampling interval 4 seconds. Set using the trend interval. 4

Sampling interval = (trend interval setting)/30 dots’
* 40 dots when the trend interval is set to 5 or 10 seconds.

Data file name Add “sample” to the file name. 5
Example: 000123 _sampleYYMMDD_HHMMSS.DAD
1 1
Sequential number Date/Time of the first recorded data
Save Destination DATA-101 6
Directory

(1) Data to be Recorded
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode).
Select the Menu tab > A/D, Memory.

tharnet,

Scan interval

Sean mode | tornal |

Scan interval 2z

A/D intearate Auto

Hemory

Data kind Displave——— 2

Hormal
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Setting the Data Storage

(2) Method of Storing to the CF Card (Auto Save ON/OFF)
Select the Environment tab > Security, Media save

Basic Setting Hode

Security

-
Communication Ooff

Save

futo save th e——3
Hedia FIFO Off

Login

(3) Save the Settings
1. Press ESC to return to the basic setting menu.

2. Press ESC once more.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER. The DX returns to the operation mode
screen.

(4) Channels to Be Recorded
Press MENU (switch to the setting mode).
Select the Menu tab > Meas channel > Tag, Memory, Delay.

; o= () )

First-CH: [EH Last-cH: a8z

Tag 1
Characters

F1-amz

Hemory sample

On/fOff on &———!

Alarm delay

Time 18 =

Input +1 -1

(5) Interval for Saving the Data to the CF Card
Select the Menu tab > Display > Trend/Save interval.

Trend / Sawve interwval

Trend interval [/divl [P 4
Save interval lday &———3

Imin 2min Smin 18min

(6) Data File Name
Select the Menu tab > Data save > File header, File name.

§@0= I (S)

1 1E:
File header

Characters

Data file name

Structure Date
Identified strinas Eamp]e e—5

Input
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Setting the Data Storage

(7) Save Destination Directory (within the CF Card)
Select the Menu tab > Data save > Save directory.

ol))

Save directory

Directory name

Input

Operation complete.
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Setting the Data Storage

Setup Example 6: Saving Measured Data at the Specified Time

Using the settings of Setup Example 5, we will save the measured data once at hour 0

every day.
Everyour 0
: DX : ' Automatically save
to the CF card

0
All settings other than those listed below are the same as Setup Example 5.

Setup Item Description Number in the Figure

Data storage time Save the data once at hour 0 every day. 7

Data storage method ~ Automatically save the measured dataat 8
the specified time.

(1) Setting the Time
Press MENU (switch to the setting mode).
Select the Menu tab > Timer, Event action > Match time timer.

GROUP 1 o -
L B BETE(S) )

Timer number

Kind Day &—m — 7
Daw 1 *———
Hour:iHinute Be:08 &
Timer action Repeat &————
Input +1 -1

(2) Specifying the Data Storage

Select the Menu tab > Timer, Event action > Event action.
R a1 11:17.00 BB (O] )
ogic box number

Event HatchTimeTiner 8
Timer number 1 E
fiction SaveDisplay

Input +1 -1

Operation complete.
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the
USER Key

In this example, we will set the DX so that the displayed screen image data can be saved
to the CF card by pressing the USER key. This function is called snapshot. The extension

of snapshot data files is .png.

YOKOGAWA 4

USER key

Setup Item Description Number in the Figure
Event action Save the screen image data of the DX 1
using the USER key.

(1) Assigning an Action to the USER Key
Press MENU (to switch to setting mode) > select the Menu tab > Timer, Event action

> Event action.

11:18:28 @DIT @ “’)

A1
Logic box number n

Event Uszerkey 1
Action Snapshot j

Input +1 -1

Operation complete.
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Customizing the Operation

Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the

Favorite key. This enables you to monitor the operation by using only the Favorite key.
This feature is convenient when comparing data such as historical trends.

Operation mode screens registered to the Favorite key
(example when three screens are registered)

Favorite key

1 B IEEEN (SR
F T1-001 °

1021

F1-882 LH

204. 4

Favorite key Favorite key

Favorite key

1. Display the screen to be registered.

2. Press FUNC once to display the FUNC key menu.
3. Press the Next soft key to display Favorite regist.

Press the Favorite regist soft key to display the registration list window.

el 0

Show the registration list window.
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Customizing the Operation

5.
6.

Press the favorite number (1 to 8) soft key.

Press the Regist soft key.
F 2:58:25 o T (O)

Show the window for entering the
display name.

Enter the screen name.
Select the input position: Left and right arrow soft keys

Enter characters: Arrow keys and DISP/ENTER

Delete a character: Use the arrow keys to select Del and press DISP/ENTER, or
press the Bs soft key.

Enter the input: Use the arrow keys to select ENT and press DISP/ENTER.

Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 17.
Press DISP/ENTER once.

Repeat steps 1 to 8 to register up to eight screens.

Operation complete.
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Starting Memory Sampling
1. Press START once.
On a DX with advanced security (/AS1 option; release number 4 or later) display the start
recording screen’. With START selected, press DISP/ENTER once.
Memory sampling starts.
* This is because the Batch function is enabled upon shipment from the factory.
Memory sampling progress

S =
@ m:":> DISP: Display data

YOKOGAWA ¢ Recording data  EVENT: Event data

.

T1-8A1

START key

Operation complete.

Stopping Memory Sampling
1. Press STOP once.

2

Display the confirmation window.

L HemtHath [ Hemary [ cancel
T
115.8‘ 281.7
clm L/H

2. Select Mem+Math or Memory using the left and right arrow keys.
Memory: Stops memory sampling.
Mem+Math: Stops memory sampling and computation (option).
On models without the computation function (option), the confirmation message “Do you

want to stop data storage?” appears. Select Yes.
3. Press DISP/ENTER once.

EoE

Stop memory sampling.

Operation complete.
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Operation

Switching the Trend Display, Digital Display, and Bar Graph Display

1. Press DISP/ENTER once to show the display selection menu.

Left arrow key

Up arrow key

Right arrow key
>) | DISP/ENTER key

L Down arrow key

Press the down arrow key to select TREND, DIGITAL, or BAR.

3. Press the right arrow key once to display the sub menu. To close the sub menu
that you opened, press the left arrow key.

4. Pressthe down arrow key to select the group.

Select DIGITAL > GROUP 1.

i F1-882
= 91.2 232.4
i C LH

5. Press DISP/ENTER once to show the operation display of the selected group. To
close the menu without switching the display, press ESC.
Group number

a1 11:31:16 -“” —m@

102 1 o denty
254 4

Operation complete.

T1-801

F1-0802

Press the down arrow key when the trend, digital, or bar graph is displayed to switch the
display in the order trend, digital, bar graph, trend, and so on. Press the up arrow key

to switch the display in reverse order. Press the right arrow key or the left arrow key to
switch the group.
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Operation

Writing the Message “START”
Registering the Word “START” in Message Number 1

On a DX with advanced security (/AS1 option; release number 4 or later), this operation
is only available when memory sampling is stopped.

1.

Press MENU (to switch to setting mode) > select the Menu tab > Message,
Comment > Message > DISP/ENTER.

Press the 1-10 soft key.
The message, “Message numbers 1-10 can also be used for free message” appears. Press
DISP/ENTER.

Press the down arrow key. With message 1 selected, press the Input soft key.
Enter “START".

| 19:50:5 o IEEE(O)ES )

Show the message registration window.

= IR - L - U L

Select the input position: Left and right arrow soft keys

Enter characters: Arrow keys and DISP/ENTER

Delete a character: Use the arrow keys to select Del and press DISP/ENTER, or
press the Bs soft key.

Enter the input: Use the arrow keys to select ENT and press DISP/ENTER.

Cancel the setting: Press ESC before pressing DISP/IENTER.

For the input procedure, see “Entering Values and Characters” on page 17.

Press DISP/ENTER.

o1 on:a1:0 = IECN (O
Hessage Mo,

Characters

ETART

Press ESC three times or MENU twice to return to the operation mode screen.
On a DX with advanced security (/AS1 option; release number 4 or later):

Press ESC three times or MENU twice to display a confirmation screen. To return
to the operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.
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Operation

Writing Message Number 1 “START”

This operation can only be carried out while memory sampling is in progress. The
message is displayed on the trend display. Show the trend display first.

1. Press FUNC (display the FUNC key menu), press the Message soft key, and
press the 1-10 soft key.

GROUP 1

Show the message registration window.

1 soft key

v 11:13 STHRT @ Shows the message.
(time, message, and message mark)
Also recorded to the internal memory.

T1-8A1 F1-A@2

9.7 169.6
(| /H

Operation complete.
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser

In this example, we will connect the PC and the DX via hub in a one-to-one relationship
and display and monitor the DX screen on a browser on the PC.

Ethernet

DX
Setup Item Description Number in the Figure
IP address 192.168.1.101 1

Subnet mask

255.255.255.0

Web server function

Monitor from a Web browser on the PC
using operator page.

Access to the DX

Display the Web page and do not set
access privileges.

PC
Setup Item Description Number in the Figure
IP address 192.168.1.100 4

Subnet mask

255.255.255.0

(1) IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode).

Select the Menu tab > Communication (Ethernet) > IP-address.

Basic Setting Hode

IP-address
DHGP

Fixed IP-address
IP-address
Subnet mask
Default gatewaw

192.168. 1.181 :71
255,266,255, @

@, @, 8. @
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Connecting to an Ethernet Network

(2) Enabling the Web Server Function on the DX
Select the Menu tab > Communication (Ethernet) > Server > Server.

Basic Setting Hode

Server

F1P

Web Usze ———2
SHTP Mot

Hodbus Use

PLG Comm Use

(3) Display the DX Screen on the PC
Select the Menu tab > Communication (Ethernet) > Web page.

0
Basic Setting Hode L

Ons0ff 0n

ficcess control off ————3

Command Mot

rator|Honi tor

(4) Save the Settings

1. Press ESC twice to return to the basic setting menu.

2. Press ESC once more.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

(5) Setting the PC
Set the IP address and subnet mask on the PC.

21x
General |
‘You can get IP settings assigned automatically if your netwark. supports
this capability. Othemwise, you need to ask your netwaork administrator for
the apprapriate IP settings.
" Obtain an P addiess automatically
—% Use the following IP address ———————————————————————
IP address: 192 168 . 1 100 @ 4
Subret mask: 256,256 256 0 @ l
Default gateway: . . .
£ (Ibtain DN server addiess automatically
—f% Use the following DNS server addiesses:————————————————
Prefermed DNS server:
Altemate DNS server.
Advanced

IM 04L41B01-02E
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Connecting to an Ethernet Network

(6) Checking the Connection
Send the command below from the PC and check that a correct response is returned.

Send
>ping 192.168.1.101

Response example

>Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1. Start the browser on the PC.
2. Enter the following URL.

http://192.168

.1.101/operator.htm

3. Check that the DX screen appears.

2} OPERATOR MODE[MAINE192.168.1.101 - Microsoft Intemet Explorer

| Fle Edt View Favorites

Tools  Help

=18l x|
I

J Dok - () - \ﬂ @ ‘h | ) search *Favnmtas P vedis Q}‘ - :\;

| Atiress [{@] hrep:f192.189.1. 101 foperator. htm

B> ENEE

Refresh

Alarm Summary

UF 1

5]
tri g

2781 @9:

Anto Refresh [l Zuum

Log.
Pnntgage
. e T
" DISF
oy e ETEOER M
T 128 168

258

Zminsdil

Select Group => =

(o)
Select Screen => ¥

r's

DISP
JENTER

v

&] Dane

[ [ meermet 7

Operation complete.
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Connecting to an Ethernet Network

Setup Example 10: Automatically Transferring the Measured Data File to an FTP

Server

In this example, we will configure the DX so that the measured data is automatically
transferred to an FTP server on the network when the measured data is automatically
saved to the CF card.

This example assumes that the following network environment is used: DHCP enabled,
automatically obtain the DNS server information, and automatically register the DX host
name to the DNS server. Set the parameters according to your network environment.

Automatic data transfer to an FTP server

DX Iﬁ FTP server
| |
/\/ = / Cr — > >oram
Measurement input

Ethernet

Setup Item Description Number in the Figure
Host name DAQSTATION1 1
Obtain the IP address Obtain automatically (DHCP) 2
Type of data to be transferred  Acquired measured data 3
FTP server Server name  abcdefg.co.jp 4

Port number 21
Login name ftpuser1
Password a1234

(1) IP Address of the DX
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode).
Select the Menu tab > Communication (Ethernet) > IP-address.

Basic Setting Hode

IP-address
DHCP .2
DNS accession Use _e———— Automatically obtain the DNS server information.
Host-name register Use &——— Automatically register the DX host name to the

DNS server.

(2) Host Settings Address of the DX
Select the Menu tab > Communication (Ethernet) > Host settings.

Host settings

Host name

Input

IM 04L41B01-02E
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Connecting to an Ethernet Network

(3) Data to Be Transferred to the FTP Server
Select the Menu tab > Communication (Ethernet) > FTP client > FTP transfer file.

Basic Setting Hode

FTP transfer file

DispkEvent data e 3

Report 0ff
Snapshot Ooff

Transfer wait time

DispkEvent data 4 min
Report @ min

(4) Connected setting FTP Server
Select the Menu tab > Communication (Ethernet) > FTP client > FTP connection.

Basic Setting Hode
FTP connection

Server name pbcdefs o—— 4
Port number 21 &
Login name If tpuserl *—
Password p1234 *—
Account

PASY mode Off

Initial path

Primary | Second

(5) Save the Settings

1. Press ESC three times to return to the basic setting menu.

2. Press ESC once more.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

Operation complete.

Executing a File Transfer Test
1. Press FUNC once to display the FUNC key menu.

2. Press the Next soft key until FTP test is displayed, and then press the FTP test
soft key.

FTP test soft key

3. Press the Primary soft key. The messages “FTP test is being executed” and
“Execution is complete” appear and the test file (FTP_TEST.TXT) is sent to the
FTP server.

Operation complete.

Transferring the Data Files
When you start memory sampling, the measured data file is transferred to the FTP server
when the data is saved to the CF card.
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD

In this example, we will display the measured data using the software program,
DAQSTANDARD.
1. Insert the CF card containing the measured data file into the PC that has
DAQSTANDARD installed.

2. Start DAQSTANDARD Viewer.

&, Data Viewer
Fle Vew Help

= = A
4 Ve i T e B

T [EEOEE E W2 SR

Ready [T ow [T

3. From the File menu, choose Open.
4. In the Open dialog box, select the desired file, and click Open.
The data is displayed.

=)
7]
-
=
o
=
)
=]
o
=]
o
=
5
@

&, Data Viewer
Fle Edit TmeAds Y-ws Miew Window Conved [nfomation Signature Help

|z@E (B e @a awemm Y e
R AR

[B] Display File-Graph[DX-000001]

I EEOEED v e (3T

Ready [T ow [T

Operation complete.
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Installation and Wiring

Installation Location
Install the DX indoors in a location that meets the following conditions.

Instrumentation Panel

The DX is designed to be installed in an instrumentation panel except for the desktop
type.

Well-Ventilated Location

To prevent overheating, install the DX in a well-ventilated location. For the panel cut
dimensions when arranging multiple DXs, see the page 51. Follow the panel cut
dimensions providing adequate space between instruments when other instruments
are arranged on the panel. For the desktop type, we recommend that a space of at
least 50 mm be provided around the left, right, top, and rear panels of the DX.
Minimum Mechanical Vibrations

Choose an installation location with the minimum mechanical vibration. Installing the
DX in a location with large mechanical vibration not only causes adverse effects on
the mechanism but also may hinder normal recording.

Horizontal

Install the DX horizontally (However, the DX can be inclined up to 30 degrees
backwards for panel mounting).

Ambient temperature range between 0 to 50°C

Ambient humidity between 20 to 80%RH (However, less than moisture
content of 40°C 80% RH at 40°C or more), No condensation should be
present.

Altitude 2000 m or less

Note

Condensation may occur if the DX is moved to another place where the ambient
temperature is higher, or if the temperature changes rapidly. In addition, measurement
errors will result when using thermocouples. If this happens, let the DX adjust to the new
environment for at least one hour before using it.

Do not install the DX in the following places.

Outdoors

In Direct Sunlight or Near Heat Sources
Install the DX in a place with small temperature fluctuations near room temperature

(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse
effects on the internal circuitry.

Where an Excessive Amount of Soot, Steam, Moisture, Dust, or
Corrosive Gases Are Present

Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid
such locations.

Near Strong Magnetic Field Sources

Do not bring magnets or instruments that produce electromagnetic fields close to the
DX. Operating the DX in strong magnetic fields can cause errors in the measurements.
Where the Viewing of the Display Is Poor

The DX uses a TFT color LCD for the display. Therefore, viewing of the display from
an extreme angle is difficult. Install the DX so that the user can view the display from
the front.

50

IM 04L41B01-02E



Installation and Wiring

Installation Procedure
Installation Procedure (Panel Mount Type)
Use a steel panel of thickness 2 mm to 26 mm.
1. Insert DX from the front of the panel.

2. Mount the DX to the panel using the mounting brackets that come with the
package as shown in the figure below.

» Use two brackets to support the top and bottom or the left and right sides of
the case (remove the seal that is covering the holes for the mounting brackets
beforehand).

» The proper torque for tightening the mounting screws is 0.7 to 0.9 Nem.

* Mount the DX to the rack according to the procedure below.

« First, attach the two mounting brackets and temporarily fasten the
attachment screws.

* Next, fix the DX in place by tightening the attachment screws with the
appropriate torque. When the DX is approximately perpendicular to the
panel as you fasten the screws, press the mounting bracket against the
case so that they are in contact with each other.

A CAUTION

» Tightening the screws too much can deform the case or damage the bracket.
» Be careful not to insert foreign objects or tools through the holes for the
mounting brackets in the case.

Panel Mounting Diagram

|Screw temporarily|

DX case

. Mounting
Mounting Panel | brackets

Attachment screw
I—Torque driver
o e} (ﬂat blade)

brackets

Attachment
screw

Front

(The figure shows the case when the mounting brackets
are used on the top and bottom of the case.)

Note

To achieve sufficient dust and water proof performance, mount the DX in the middle of the
panel cut out.

Installation (Desktop Type (/H5[ ] Option)
The front (leg) stand can be pulled out.

CAUTION

On the desktop type, do not apply force to the DX when the front leg (stand) is
out. This can break the front leg.
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Installation and Wiring

External Dimensions and Panel Cut Dimensions
Unit: mm (approx. inch)

Unless otherwise specified, tolerance is *3%
(however, tolerance is £0.3 mm when below 10 mm).

Panel mount type = : DX1000 | DX1000N
*1 [ 228.5 (9.0) |258.5(10.18)
=) 0 2|5 [*2]224.1(8.82) [ 254.1 (10.0)
@lw [*3[170.5 (6.71) [ 200.5 (7.89)
*4 140.9 (1.61) [30.9 (1.22)
*5(41.4 (1.63) |34.9 (1.37)
*6 | 103.4 (4.07) | 103.4 (4.07)
MAX *1 (/H2 or /PM1) *7 199.9 (3.93) |106.3 (4.19)
24.0 *2 o _
151.5 (5.96) (0.94) 3 e ey 9
144 (5.67) 2t0 26 =
4 {{Allowable pane thick 32
= |( owable panel thickness) =3
\ ]
| @ (@) 0
= |
S| 3 =) 0 Lr 0|
©| o il gl@
~ 3l 2 cle
* 3 ;
:ﬂT - i
6 MAX 28.0 (1.10) 5
(/KB1 or /[KB2) S
! (Dimensions after attaching

Panel cut dimensions

the mounting bracket)

Single-Unit Side-by-Side Mounting Side-by-Side Mounting
Mounting (horizontally) (vertically, max. 3 units)
13742 . 2
1377% Units L'3
(5.39) - T (539) | 2 282 (11.10)
- 3 [426 (16.77)
|1 470 2 4 [570 (22.44)
T T7T(5:39) 4abe2 ' 5 [714(28.11)
R A - =l 1 [ 6 |858(33.78)
i ! ' o 7 (1002 (39.45)
L2 8  [1146 (45.12)
2 9 [1290 (50.79)
10 [1434 (56.46)
1 n_ |(144xn)-6

175 MIN
(6.89)

Desktop type (/H5[ ] Option)

[
[

138.8
(5.46)

MAX 252.5 (99.4) (/H2 or /PM1)

( A

144.3
(5.68)

(1.57)

o
<

T
il

(1.55)

39.3

144.3
(5.68)
143

(5.63)

i
(0.57)
15|
(0.59)

14.4
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Installation and Wiring

Input Signal Wiring

A\ WARNING.

« To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

CAUTION

+ If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

» To prevent fire, use signal wires having a temperature rating of 70°C or more.

» Do not apply a voltage exceeding the following value to the input terminals.
Otherwise, damage to the DX may result.

* Maximum input voltage: +60 VDC
* Maximum common mode voltage: +60 VDC (under measurement category Il

conditions)
. _________________________________________________________________________________________________________________|

Precautions to Be Taken While Wiring
Take the following precautions when wring the input signal cables.

When using a screw terminal, we recommend that you use a crimp-on lug
with an insulation sleeve (designed for 4-mm screws).
Crimp-on lug with insulation sleeves (for 4 mm screws)

When using a clamp terminal (/H2), we recommend that you use the

following kind of cable:
» Conductive cross-sectional area: 0.08 mm2 to 1.5 mm2 (AWG 28 to 16)
» Length of the stripped section of the wire: Approx. 7 mm

Take measures to prevent noise from entering the measurement circuit.

* Move the measurement circuit away from the power cable (power circuit) and ground circuit.

» ltis desirable that the object being measured does not generate noise. However, if
this is unavoidable, isolate the measurement circuit from the object. Also, ground the
object being measured.

» Shielded wires should be used to minimize noise caused by electrostatic induction.
Connect the shield to the ground terminal of the DX as necessary (make sure you are
not grounding at two points).

» To minimize noise caused by electromagnetic induction, twist the measurement circuit
wires at short, equal intervals.

» Make sure to earth ground the protective ground terminal through minimum resistance
(less than 100 Q).

Do not allow static electricity to be applied to the terminals.

*  When wiring the terminals, remove static electricity so that static electricity is not applied.

« If static electricity or similar high-voltage transient noise is applied to the signal line,
the system may break.

When using internal reference junction compensation on the thermocouple

input, take measures to stabilize the temperature at the input terminal.

» Always use the terminal cover.

» Do not use thick wires which may cause large heat dissipation (cross sectional area of
0.5 mm? or less recommended).

» Make sure that the ambient temperature remains reasonably stable. Large
temperature fluctuations can occur if a nearby fan turns ON or OFF.

Connecting the input wires in parallel with other devices can cause signal

degradation, affecting all connected devices. If you need to make a parallel

connection, then

» Turn the burnout detection function OFF.

* Ground the instruments to the same point.

* Do not turn ON or OFF another instrument during operation. This can have adverse
effects on the other instruments.

* RTDs cannot be wired in parallel.
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Installation and Wiring

Wiring Procedure
A terminal cover is screwed in place on the measuring input terminal block on the rear

panel. A label indicating the terminal arrangement is affixed to the cover.
1. Turn OFF the DX and remove the terminal cover.

2. Connect the signal wires to the terminals.

Recommended torque for Screw terminals 0.9t0 1.0 N-m
tightening the screws Clampted terminals  0.22 to 0.25 Nem

3. Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 Nem.

Nofte
Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make
sure that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

& ﬁ-— Input terminal block

Screw terminal Clamp terminal
CH2
CH1 CH1
Input terminal block of b ?I?A
the DX1002 and DX1002N %% A @EZB
@& -/B CH2
CH4 CH2
CH3 CH1 CH3 g-l1
Input terminal block of PR b T ?-{-?A
the DX1004 and DX1004N RIRD YA ﬂ @E -IB
BRSD -/B CH4 CH2
CH6 CH4 CH2
CH5 CH3 CH1 CH5 CH3 CH1
Input terminal block of | R R b Bl TEN T b
the DX1006 and DX1006N RRPRDRD YA -/B
896969696 B CH6 CH4 CH2
CH12 CH10 CH8 CH6 CH4 CH2
H11 CH9 CH7 CH5 CH3 CH1 C CH5 CH3 CH1
Input terminal block of @@@@@@@@@@@® b S S S b
the DX1012 and DX1012N ®®®®®®®®®®®® VA -IB
®®®®®®®®®®®® -IB CH12CH10 CH8 CH6 CH4 CH2
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Installation and Wiring

Wiring Screw Terminals
DC voltage input/DI (ON/OFF) input TC input

Compensating leadwire

+ +
+

DC voltage input _+

t_r \I_)
\)
RTD input DC current input
b
A \ + +
2 .

B A DC current input

B — -

b

Shunt resistor

2l Example: For 4 to 20 mA input, use a
shunt resistor of 250 Q+0.1%.

Lead wire resistance per wire of
10 Q or less. Make the resistance

of the three wires equal.

Wiring Clamped Terminals

CAUTION

As of August, 2007, the direction of the terminal blocks for the clamp input terminals
(/H2 option) has changed. To use clamp input terminal blocks wired for use with
previous YOKOGAWA recorders, rewire them to match the DX.

5
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1
o
=8
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L
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Q
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(]

Remove the terminal block Connect the wires Connect the terminal block

Hold both ends of the terminal Hold both ends of the terminal block,
block and pull straight. align with the connector on the DX
side, and push the terminal block into
the connector.

)/,

by,

V) N) YN N
R

d
/N
4

JRIQFA5A
74\

A

A

= Recommended N Flat-blca:clie

% length of stripped ~_ @R A screwdriver

L wire: 7 mm / "\
Recommended wire size \((@ ,‘,
0.08 to 1.5 mm? (AWG 28 to 16)

Input signal wire

First, loosen the screw at the front using a flat-blade
screwdriver. Insert the input signal wire into the slit on the

left side of the terminal block, and fasten the screw at the front.

Nofte
RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally
across all channels. However, terminal b is also isolated on each channel on models with the
/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).
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Installation and Wiring

Optional Terminal Wiring

A

To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

If a voltage of more than 30 VAC or 60 VDC is to be applied to the output
terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals
to prevent the wires from slipping out when the screws become loose.
Furthermore, use double-insulated wires (dielectric strength of 3000 VAC or
more) for the signal wires on which a voltage of more than 30 VAC or 60 VDC is
to be applied. For all other wires, use basic insulated wires (dielectric strength of
1500 VAC). To prevent electric shock, attach the terminal cover after wiring and
make sure not to touch the terminals.

CAUTION

Use the following circuit voltage for the connection to the alarm/FAlL/status
output terminal.
*  When the connection is to Mains Circuits (primary AC power source circuits):

150 V or less
*  When the connection is to circuits derived from Mains Circuits (secondary
circuits): 250 V or less

(Mains Circuits voltage is less than 300 V, and connection must be used by
isolation transformer.)
To prevent fire, use signal wires having a temperature rating of 70°C or more.
If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting
panel.
Do not short the transmitter power supply output terminal or apply external
voltage to it. If you do, the DX may malfunction.
When using the transmitter power supply output terminal, do not use current
that exceeds the maximum output current (25 mADC). If you do, the DX may
malfunction.

Note

For remote control wiring, use shielded wires to reduce noise. Connect the shield to the

functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed
for 4-mm screws) be used when connecting wires to the optional input
terminals.

@@—Crimp-on lug with insulation sleeves (for 4-mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear
panel. The optional terminal block is provided on the DX when an option that requires
input/output is installed such as the alarm output relay (/A[ ] option), FAIL/status output
relay (/F1 option), and remote control function (/R1 option), etc. A terminal cover is
screwed in place on the measuring input terminal block. A label indicating the terminal
arrangement is affixed to the cover.

1.
2,

Turn OFF the DX and remove the terminal cover.

Connect the signal wires to the terminals. The recommended torque for tightening
the screws is 0.9 to 1.0 Nem

Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 Nem.
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Installation and Wiring

Arrangement of the Optional Terminals

e-H— Optional terminal block
=
e
Symbols such as “NC”: Terminal functions
Alarm output, FAIL, Status Remote control input Pulse input Transmitter power supply
NC: Normally closed 1 to 8: Terminal number Hand L: See page 58. +and-: See page 58.
C: Common C: Common
NO: Normally opened See page 58.
See page 58.
A terminal that is not used. (With a screw)
|:| A terminal that is not used. (Without screw)
IA1 1A2 IA3
Alarm Alarm Alarm
output output output
/—/% r N
02 01 04 03 02 01 06 05 04 03 02 01
&) @G (@)INc| INc & GDINC|  [Nc|Nc| [Ne NC| Inc|Nc| |Nc|Nc| [nc
&) @ @|c| |c & ®@c| |c|c| |c €l |clc| |c|c| |c
&) ) ((9INo|  |No @ GPINo|  [No|No|  [NO NO|  |No|no| |No|No| [NO _
2
0
IA1/R1 IA2/R1 IA3/R1 g'-
Alarm Remote Alarm Remote Alarm Remote s
output cpntr?l output Ci?\?fﬂ?' output Cﬁ)]r;tﬂ?l S
— inpu — P N\
02 01 —— 04 0302 o1 —~— 06 0504 0302 O, A ;
&) @) (DInc| [Nc|6 |3 (¢ & (@INc| |Nc|nc| [Nc|6 |3 [c] [NC| |nc|nc| [Nc|Nc| nc|6 |3 [ =
O @@ (@ c| |cl7laq] @ @ c| [clc| [c|7]al7] <l [cle]| [c]e cl7l4]4 @
D @@ (@Ino| [nols |52 (€ [@Ino| [nojno| [no|s |5 2| MO |noNo| [Nolno| Noj8 |5 |,

IR1 /A1 IF1 /A2 IF1
Remote Alarm Alarm
| Status
%%f’;tlrj? FAIL output FaL Status output
v 02 o1 v 04 0302 01
cl NS INc[@®) [ @INc| |nc NC| Inc|nc| |nc|nc| |Nc
11 L& [cl®@ [@c| |c Cl |clc| |clc| |c
8[5(2] N9 [Nno[@) |GDNo| [NO NO|  Ino[No| |no[NO| [NO
IF1 IA1 [F1 IR1 A2 [F1 IR1
Alarm Remote Alarm Remote
FalL  Status FAlL Status output control FAIL Status output control
v l v input v —_— input
02 01— l 04 03 02 01—
NCI Il @D [ NC| INc|@® |@®)INc| [Nc|6 |3 | [NC| |Nc|nc| |nc|nc| [Nc|6 |3 [
°l @ ¥ @ ©l [c[@ [@c| |c|r|afq| [ |ele| |cfc| |c|7 |4y
NOl Ino[3?)) @D (D NO|  Ino(@)| |@)INo| [Noj8 |5 [, | [N |[NojNo| [NoNo| [Nofs |55

(To next page)
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Installation and Wiring

IF1/R1
s Remtonla
paL Status ci%?) G?
—
N Ine[®) @B [ @)s |3 ¢
C
@ P& (@74
NO no[@) (BB (@852
/A1 /F1 /PM1
Al Pulse Remote
Status oueirpﬂt i#put control
FAIL A input
02 01 8 7 6
NC| Inc|nc| |Nc| |H|H|H|3[¢
€l fclc| [c| |L|L|L|afy
NO|  INo|No| [no 5[5
/A1 /TPS2
Transmitter Alarm
power output
supply
— 02 o1
*l+ NC| |NC
- c Cc
NO NO
ITPS2
Transmitter
powelr
supply
~—
++

WR®
R®

(From previous page)

/A1 /PM1
Alarm Remote
output lTrlflsuet control
b input
02 01 8 7 6 =
& GONC| INc| |H[H|H|3[¢
& @c| [c| |L|L|L|aly
& G9No|  |No 2
/PM1
Pulse Remote
input control
input
8 7 6 '
H[H|H|3[¢
LiL|L|4(y
2
/A1 IR1 ITPS2
Transmitter Alarm Remote
power output control
supply input
PRvuY 02 0 —
t+ NC| [NC|6 c
T - Cc C 4 1
No| [No|8 |5 [,
IR1 /TPS2
Transmitter Remote
power c_ontrol
supply input
~—
T+ & (@63 ]c
-l - & (@744
&) (@ e]5]2

/A2 IPM1
Alarm Remote
output lTrl\Jrl)Suet control
input
04 03 02 01 8 7 6
NCl INc|nc| Nc| |H|H|H|3[¢
€l lecle| |c| |L|L|L|afy
NOl  INo|no| [NO 55
[F1 /PM1
Pulse Remote
Status input control
FAIL input
l 8 7 6 N
NC
ne@] [@] [n[n[n]s e
€l [cl@ @ |L|r|L|4]q
NO
NOE) (@ 5 [2
ITPS4
Transmitter
power
supply
]+
IR1 /TPS4
Transmitter Remote
power cpntrol
supp|y input
+
+ |+ |+ 6(3 ¢
=== 7144
8|5 2

58
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Installation and Wiring

Alarm Output Terminal (/A1, /A2, and /A3), FAIL Output Terminal, and Status
Output Terminal (/F1)

NC Output format: Relay contact FAIL
c Contact rating: 250 VAC (50/60 Hz)/3 A, output N{}; Nlc Nlo é/Nlc Nlo ‘;/Nlc
250 VDC/0.1 A (for resistor load) | (/F1) During normal ~ When a failure  When power is
NO Withstand voltage: 1600 VAC at 50/60 Hz for one operation ocours turned OFF
minute (between output terminals | Other l A l\ l [ /l
and the ground terminal) output NOCNC NO C NC NOCNC
(/F1) During normal ~ When specified ~ When power is|
operation status occurs turned OFF

Remote Control Input Terminal (/R1)

* Relay contact input * Transistor input (open collector) Internal circuit
(voltage-free contact)
Contact closed at 200 Q or less ON voltage: 0.5V or less (30 mADC) v Input format:

Contact open at 100 kQ or greater ~ Leakage current when turned OFF: Photocoupler isolation
0.25 mAor less Shared common (C)

) 5
I @_% Allowable input voltage:
6 3 c c 5VDC
7 4 1 ' 37
8 5 2

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

Pulse Input Terminal (/PM1)

* Relay contact input *Transistor input (open collector) Internal circuit
(voltage-free contact) .
Contact closed at 200 Q or less ON voltage: 0.5V or less (30 mADC) |
Contact open at 100 kQ or greater ~ Leakage current when turned OFF: i
0.25 mA or less E

-
t
(<]

5V Input format:
Photocoupler isolation
Shared common (L)
Allowable input voltage:

Foick g FE 5T

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

24 VDC Transmitter Power Supply Output Terminal (/TPS2 and /TPS4)
Connect the DX to the transmitter as shown below.

Current Note

To reduce noise, use a shielded cable for wiring.
Connect the shield to the functional ground
Transmitter terminal or the ground terminal of the DX.

DX

Transmitter power
supply output terminal

Input terminal

Shunt resistor: 250 Q

Serial Interface
Connecting to the RS-232 Connector (/C2)

12345 2 RD (Received Data): Received data from the PC. Input signal to the DX.
\ | | | 3 SD (Send Data): Transmitted data to the PC. Output signal from the DX.
LS 5 SG (Signal Ground): Signal ground.
@ 0000 @ 7 RS (Request to Send): Handshaking signal when receiving data from the PC. Output signal
from the DX.
é ; L \9 8 CS (Clear to Send): Handshaking signal when transmitting data to the PC. Input signal to
the DX.
(male) * Pins 1, 4, 6, and 9 are not used.
Connecting to the PROFIBUS-DP Connector (/CP1)
54321 3 RxD/TxD-P: Positive data input/output.
| | | 4 CNTR-P: RTS (needed when using a repeater).
Te 5 DGND: Ground.
@ 0000 @ 6 VP +5V: +5 V.
R 8 RxD/TxD-N: Negative data input/output.
9876 * Pins 1, 2,7, and 9 are not used.
(female) ** The DX does not have a built-in terminator. If you need to terminate the cable at the DX,

use a terminated connector.
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Installation and Wiring

Connecting to the RS-422/485 (/C3)

Four-wire system Two-wire system
o o|ao O | 0| gemif+ FG (Frame Ground) Frame ground of the DX.
%) %% % %%, SG (Signal Ground) Signal ground.

z
i

=1 ]
QY
E @ SDB (Send Data B) Send data B (+).

o a
Qo
ﬁ E SDA (Send Data A) Send data A (-).

I | N - RDB (Received Data B) Receive data B (+).

1 1 1 1
TN Ris RFA FG SG SDB SDA RDB RDA  RPA (Received Data A) Receive data A (-).
< Shield

Electric potential of the shield

Recommended length of stripped wire: 9 mm. Recommended tightening torque: 0.4-0.5 Nem

Cable

There are two types of cables available, the four-wire cable and the two-wire cable (used only for the
Modbus protocol). The cable should meet the following specifications.

* Type:

Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire),
2 pair 24 AWG or more (two-wire)

* Characteristic impedance: 100 Q
+ Capacitance: 50 pF/m
+Total cable length: Upto 1.2 km

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.

Front Rear
]

lrlSB port

E

@[]~ USB port

CF_CARD

1

Connecting to the Ethernet Port

Ethernet port

[ Indicator CAUTION

Do not connect an Ethernet cable whose plug does
not comply with FCC specifications. If you do, the

DX may malfunction.
|

Checking the Connection/Communication Status
You can check the connection status of the Ethernet interface with the indicators that are
located above the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Blinking (red) Transmitting data.

Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display

Checking the Connection at the status indication section of the DX
display.

You can check the connection status of the Ethernet interface on the Ethernet Link
indicator located on the right side of the status display section of the basic setting
mode display. The basic setting menu appears by pressing MENU to display the
setting menu followed by FUNC for approximately 3 s.

Checking the Connection Status in the Display Section in the Upper
Right Corner of the COMMUNICATION LOG Display of the DX
You can check the connection status of the Ethernet interface on the Link indicator on

the display section in the upper right corner of the COMMUNICATION LOG display.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.
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Installation and Wiring

Power Supply Wiring
Panel Mount Type, or Desktop Type with /P1 (Models with /H5 and /P1 Options)
Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. To prevent electric
shock and damage to the DX, observe the following warnings.

A (WARNING

» To prevent electric shock when wiring, ensure the main power supply is turned
OFF.

» To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20-16) or
an equivalent wire for power wiring.

* Make sure to earth ground the protective earth terminal through a grounding
resistance less than 100 Q before turning ON the power.

» Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply
wires and protective grounding wires.

» To prevent electric shock, make sure to close the transparent cover for the
power supply wires.

» For safety, provide a double-pole switch in an easily operable location near the
DX to disconnect the DX from the main power supply. Put an indication on this
switch as the breaker on the power supply line for the DX and indications of ON and
OFF. Switch specifications

Steady-state current rating: 1 A or more (other than /P1), 3 A or more (/P1).
Inrush current rating: 60 A or more (other than /P1), 70 A or more (/P1).
Use a switch complies with IEC60947-1, 3.

» Connect a fuse (between 2 A and 15 A) to the power line. Use a fuse approved 5
by CSA (for the use in North America) or VDE (for the use in Europe). E’;
» Do not add a switch or fuse to the ground line. g’-
;
Use a power supply that meets the following conditions: o
Item Other than /P1 /P1 EE‘
Rated supply voltage 100 to 240 VAC 24 VDC/AC (g
Allowable power supply voltage range 90 to 132, 180 to 264 VAC 21.6V to 26.4 VDC/AC
Rated power supply frequency 50/60 Hz 50/60 Hz (for AC)
Allowable power supply frequency range  50/60 Hz + 2% 50/60 Hz + 2% (for AC)
Maximum power consumption 45 VA (100 V)/60 VA (240 V) 28 VA (for DC), 45 VA (for AC)
Nofte

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Wiring Procedure
1. Turn OFF the power to the DX and open the transparent power terminal cover.
2. Wire the power cord and the protective ground cord to the power supply terminals.

Use ring-tongue crimp-on lugs (designed for 4 mm screws). The proper torque for
tightening the screw is 1.4 to 1.5 Nem (12.4 to 13.2 inchelbs).

> Other than /P1 /P1
SR \ (24 VDC/AC power supply)
20D oy, |\, | NI, ¥ - =
GEEsss B
== = |- < (] (L) [ O]
Note

Do not wire the protective grounding
cord to the functional ground terminal.

Power cord

3. Replace the power terminal cover, and fasten it with screws.
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Installation and Wiring

Desktop Type (/H5[ ] Option)

Precautions to Be Taken While Connecting the Power Supply

Make sure to follow the warnings below when connecting the power supply. To prevent
electric shock and damage to the DX, observe the following warnings.

A

Before connecting the power cord, ensure that the source voltage matches the
rated supply voltage of the DX and that it is within the maximum rated voltage
range of the provided power cord.

Connect the power cord after checking that the power switch of the DX is turned
OFF.

To prevent electric shock or fire, be sure to use the power cord supplied by
YOKOGAWA.

Make sure to perform protective earth grounding to prevent electric shock.
Connect the power cord of the desktop type to a three-prong power outlet with a
protective earth terminal.

Do not use an extension cord without protective earth ground. Otherwise, the
protection function will be compromised.

Use a power supply that meets the following conditions:
Item Condition
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC
Rated power supply frequency 50/60 Hz
Allowable power supply frequency range 50/60 Hz + 2%

Maximum power consumption

45 VA (100V) and 60 VA (240 V)

Note

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Connection Procedure

1.

Check that the power switch is OFF.

2. Connect the power cord plug to the power connector on the rear panel. (Use the

power cord that comes with the package.)

3. Check that the power outlet meets the conditions given in the table above and

that the supply voltage is within the maximum rated voltage range of the power
cord that comes with the package. Then, connect the other end of the power cord
to the power outlet. The AC outlet must be of a three-prong type with a protective
earth ground.

62

IM 04L41B01-02E



Recommended Replacement Periods for Worn Parts

To preserve the reliability of the DX and to use the DX in a good condition for an
extended time, it is recommended that periodic replacements be made on parts. The
replacement parts may change to accommodate preventive maintenance over extended
time. Be sure to check with your nearest YOKOGAWA dealer.

The following table shows the recommended replacement period for expendable parts.
The replacement period shown here applies when the recorder is used under standard
operating conditions. For the actual replacement period, consider the actual conditions
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when such
replacement is necessary.

Item g:g:,ac;:ement Name Part No. Szzgtlty Notes
LCD 5 years TOP BEZEL Assembly B8705KY 1 For DX1000 Style number H: 5
without /KB1 and KB2 options
B8705KZ 1 For DX1000 Style number H: 5
with /KB1 or KB2 option
B8705KB 1 For DX1000N Style number H: 5
without /KB1 and KB2 options
B8705KJ 1 For DX1000N Style number H: 5
with /KB1 or KB2 option
Battery 10 years Battery Assembly B8800ZK 1
Dust and water 5 years Packing B8705FY 1
proof strip 5 years Key Case Assembly B8705BM 1 Without /KB1 or /KB2
5 years Key Case Assembly B8705BY 1 With /KB1 or /KB2
Aluminum 5 years* Power Supply Assembly |- 1
electrolytic capacitor |5 years* AD Assembly Depends on the model

* Replacement period at the upper limit of the normal operating temperature (50°C)
The replacement period varies depending on the operating temperature and the specifications of the DX.
The lower the operating temperature, the longer is the replacement period. For example, if the operating
temperature is 30°C, it may be possible to use the parts for more than 10 years.

Nofte

« The LCD replacement period indicates the half life of the brightness when the brightness
is set to the factory default setting. The half life is shortened as the brightness is set
higher. The deterioration of brightness varies depending on the condition of use, and its
determination is subjective. Consider these facts for determining the actual replacement
period.

* The color of the LCD may become yellowish as time elapses. The discoloration tends to
progress faster as the brightness is set higher.
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Setup Items and Default Values

The setup items and the default values in the setting mode are listed below. Enter the
settings that you are using in the Setting column for your convenience.

Date/Time ©

Heaz channel ®

Hath channel ®

Dizplaw @

Group set. Trip line ®

Hezzage. Comment Text®

Timer, Event action ®

Data zauve ®

Web Report e

Henu customize ®

-

Henu customize
Basic zetting mode o

t End: /AS1 option e

Group zet. Trip line o

File header. File name e

Batch text o

d Bd:43
Hulti batch |

Calibration correction e
Finish Calibration e

Henu | Hulti batch | NI | ¥

Load dizplaw data e

Load event data e
Load zettingz e

Save settings e
Cuztom dizplay Toade

w

-

Custom display savee
Load template o

Save template o

File lTiztidelete o

Format o

*: Optional.

Page 65

Page 65 to 67
Page 68 and 69*
Page 70

Page 71

Page 71

Page 71 to 73
Page 74

Page 74*

Page 74

Page 74

Page 74*

Page 75*
Page 75*
Page 75*

Page 75*
Page 75*

Page 75
Page 75
Page 76
Page 76
Page 76
Page 76
Page 76*
Page 76*
Page 76
Page 76

IM 04L41B01-02E



Setup Items and Default Values

Basic setting mode menu

Basic Setting Hode

Erwi ronment ] Henu ]Fi lefInitial ize]
Operating environment Page 77
Yiew, Hezsage Page 77
Input. Tag @ Page 77
Alarm 14 Page 77
Femote ® Page 77*1
Security. Hedia save Page 78
Batch e Page 78
Commur i cat i o 14 Page 78
Hath @ Page 78*1
Fepaort @ Page 79*1
Report
End e Page 79
Basic Setting Hode
Ervsi ronment ]]Filex’lnitialize]
Alarm @ 4 Page 80
_.IEU"D; Hemore Page 80
Burnout, RIG e Page 80
Few] oo b Page 81*2
Lagine 14 Page 81*2
Reporée b Page 83*1
Time settings e Page 83
Communication {(Etherneié— Page 84 to 87
~Gommunication {(Serial}®—F Page 88*1
Status relas Page 89*1
Statuz relav e 3 Page 89
Set Calibratione Page 89

End

—Communication (PROFIBUS-DP): For models with e&— Page 88*1
thePROFIBUS-DP interface (/CP1 option).

— Signature: For models with the Advanced Security e—— Page 80*1

(/CP1 option).

Basic Setting Hode

Erw i ronment ] Herw ] ilefInitialize

Load =ettings® Page 90

Initializ® Page 90

Media eject® 14 Page 90

End® Page 90
*1: Optional.

*2: Displayed when the function is enabled in the Environment settings.
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Setup Items and Default Values

This section uses the following notations in tables.

*1: This indicates functions that are available for release number 2 or later.
*2: This indicates functions that are available for release number 3 or later.
*3: This indicates functions that are available for release number 4 or later.

Menu tab 2
Date/Time > Date&Time
Setup Item Selectable Range or Selections Default Value Setting
Date&Time > Time set - 2008/01/017
00:00:00
Date/Time > Daylight Saving Time
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ MAR
OCT/NOV/DEC
Start time > Day order 1st/2nd/3rd/4th/Last 2nd
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ NOV
OCT/NOV/DEC
End time > Day order 1st/2nd/3rd/4th/Last 1st
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value 1
Meas channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Range > Mode Skip/Volt/TC/RTD/Scale/Delta/Dl/ Volt
1-5V/Sqrt
Mode=Volt
Range 20mV/60mV/200mV/2V/6V/20V/50V 2V
Span Lower Depends on the range. -
Span Upper Depends on the range. —
Mode=TC
Range R/S/B/K/E/JITIN/WI/L/U/WRe R
Span Lower (Options may add additional settings.) -
Span Upper Depends on the range. -
Depends on the range.
Mode=RTD
Range Pt/JPt (Options may add additional settings.) Pt
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Mode=Scale
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower -30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Mode=Delta
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Ref.CH Meas channel number —
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Setup Items and Default Values

Setup Item Selectable Range or Selections Default Value Setting
Mode=DI
Range Level/Cont Level
Span Lower 0,1 0
Span Upper 0,1 1
Mode=1-5V
Range 1-5V 1-5V
Span Lower 0.800 to 5.200 1.000
Span Upper 0.800 to 5.200 5.000
Scale Lower —30000 to 30000, decimal position :0 to 4 0.00
Scale Upper —30000 to 30000, decimal position :0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Mode=Sqrt
Range 20mV/60mV/200mV/2V/6V/20V/50V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Low-cut value 0.0t0 5.0 0.5
Alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/h:delta H/l:delta L/R:rate H/ H
rirate L/T:delayH/t:delayL
Value Numerical value -
Relay On/Off Off
Number 101/.../106 (Depends on the option.) 101
S01/S02/S03/.../S29/S30
Detect On/Off On

Meas channel > Tag, Memory, Delay

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
First-CH, Last-CH Channel number 001
Tag > Comment 2 32 characters or less ~ —
Tag > No. 2 16 characters or less —
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
With /AS1”
The First-CH, Last-CH, Tag, and Memory sample items are the same as on a DX without the /AS1 option.
Alarm delay > Time 1 to 3600 when the unit is seconds. 1 to 24 when 10
the unit is hours.
Alarm delay > Unit Hour/Sec Sec

Meas channel > Moving average

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001

Moving average > On/Off On/Off Off

Moving average > Count 2 to 400 2
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Setup Items and Default Values

Meas channel > Color

Setup Item Selectable Range or Selections Default Value Setting

Group of channel 001-006, etc Depends on the model.

Color Red/Green/Blue/B.violet/Brown/Orange/ Red to Gray
Y.green/Lightblue/Violet/Graly/Lime/Cyan/
Darkblue/Yellow/Lightgray/Purple/Black/Pink/
L.brown/L.green/Darkgray/Olive/DarkCyan/

S.green (24 colors)

Meas channel > Zone, Scale

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

Zone > Lower 0to 95 0

Zone > Upper 51to 100 100

Scale > Position Off/1/2/3/4/5/6 1

Scale > Division 4/5/6/7/8/9/10/11/12/C10 10

Meas channel > Bar graph

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

Bar graph > Base position Normal/Center/Lower 1/Upper1 Normal

Bar graph > Division 4/5/6/7/8/9/10/11/12 10

Meas channel > Partial

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

On/Off On/Off Off

Expand 1 t0 99% 50

Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

Mark kind Alarm/Fixed Alarm

Indicate on Scale On/Off Off

Alarm mark color > Alarm 1 Auto'2/Red/Green/.../S.green (24 colors) Red

Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark color > Alarm 4 Same as Alarm 1 Red

Meas channel > Color scale band

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

Band area Off/In/Out Off

Color Red/Green/.../S.green (24 colors) Lime

Display position > Lower Measuring range 0.0000

Display position > Upper Measuring range 0.0100

Meas channel > Calibration correction
Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH

Channel number

001

Number of set points

Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16

Off

1 to n > MES val
1ton > True val

Value in the measuring range/measured value

Measuring range
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Setup Items and Default Values

Math channel > Expression, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Math On/Off On/Off Off
Calculation expression 120 characters or less -
Span Lower —9999999 to 99999999, decimal position: 0 to 4 —200.00
Span Upper —9999999 to 99999999, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Math alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL H
Value Numerical value -
Relay On/Off Off
No. 101/.../106 (Depends on the option.) 101
S01/S02/S03/.../S29/S30
Detect On/Off On
Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant K01 to K60 K01
Value —9.9999E+29 to —1.0000E-30, O, 1
1.0000E-30 to —9.9999E +29
Math channel > Tag, Memory, Delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Tag > Comment 2 32 characters or less —
Tag > No. 2 16 characters or less -
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
TLOG > Timer type 2 Timer/Match T Timer
TLOG > Timer No. 1/2/3/4 1
1/2/3/.../11/12 (on models with the /BT2 multi
batch option)*2
TLOG > Sum scale Off, /s, /Imin, /h Off
TLOG > Reset On/Off Off
Rolling average > On/Off On/Off Off
Rolling average > Interval 1s/2s/3s/4s/5s/6s/10s/12s/155/20s/30s/ 10s
1min/2min/3min/4min/5min/6min/10min/12min/
15min/20min/30min/1h
Rolling average > Number of samples 1 to 1500 1
Math channel > Color
Setup items and values are the same as those for measurement channels, except the channel numbers.
Math channel > Zone, Scale
Setup items and values are the same as those for measurement channels, except the channel numbers.
Math channel > Bar graph
Setup items and values are the same as those for measurement channels, except the channel numbers.
IM 04L41B01-02E 69
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Setup Items and Default Values

Math channel > Partial

Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Alarm mark
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Color scale band
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Math start action

Setup Item Selectable Range or Selections Default Value Setting
Math start action > Math start Off/Start/Rst+St Start
Display > Trend/Save interval
Setup Item Selectable Range or Selections Default Value Setting
Trend interval [/div] 5s /10s 2/15s/30s/1min/2min/5min/10min/15m  1min
in/20min/30min/1h/2h/4h/10h (Depends on the
model.)
Save interval 10min to 31day (Depends on the trend interval.) 1h
Second interval [/div] 5s 2/10s 2/15s/30s/1min/2min/5min/10min/15m
in/20min/30min/1h/2h/4h/10h (Depends on the  1min
model.)
Display > Trend
Setup Item Selectable Range or Selections Default Value Setting
Direction Horizontal/Vertical/Wide/Split Vertical
Trend clear On/Off Off
Message direction Horizontal/Vertical Horizontal
Scale > Digit Normal/Fine Normal
Scale > Value indicator Mark/Bargraph Mark
Trend line 1/2/3 2
Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Display > Bar graph
Setup Item Selectable Range or Selections Default Value Setting
Direction Horizontal/Vertical Vertical
Display > LCD
Setup Item Selectable Range or Selections Default Value Setting
Brightness 1/2/3/4/5/6/7/8 2
Backlight saver > Mode Off/Dimmer/Timeoff Off
Backlight saver > Saver time 1min/2min/5min/10min/30min/1h 1h
Backlight saver > Restore Key, Key+Alarm Key+Alarm
Display > Monitor
Setup Item Selectable Range or Selections Default Value Setting

Background > Display
Background > Historical trend
Scroll time

Jump default display

White/Black

White/Cream/Black/Lightgray
5s/10s/20s/30s/1min
Off/1min/2min/5min/10min/20min/30min/1h

White
Black
10s
Off
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Display > Annunciator 2

Setup Items and Default Values

Setup Item Selectable Range or Selections Default Value Setting
Annunciator position 1t024 1

On/Off On/Off Off

Channel Channel number 001

Level 1 /2/3/4/All 1

Comment txt block No. 1to 50 1

Display > FAVORITE Key action 2

Setup Item Selectable Range or Selections Default Value Setting
Action History/Favorite Favorite

Group display Current/Saved Saved

Time axis zoom Current/Saved Saved

Group set, Trip line

Setup Item Selectable Range or Selections Default Value Setting
Group number 1/2/3/...19/10 1

Group set > On/Off On/Off Group 1to 4: On

Group set > Group name
Group set > CH set

16 characters or less
39 characters or less

Group 5 to 10: Off
GROUP1 etc.
Depends on the model.

Trip line

1,2,3,4 On/Off Off

Position 0to 100 50

Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green

3:Blue, 4:Yellow

Width 1/2/3 2
Message, Comment Text? > Message
Setup Item Selectable Range or Selections Default Value Setting
Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 11-20"3

61-70/71-80/81-90/91-100

1to 100 32 characters or less -
Message, Comment Text > Comment text fields 2
Setup Item Selectable Range or Selections Default Value Setting
Coment txt field no 1to 100 1
Text info 32 characters or less —
Message, Comment Text > Comment text block 2
Setup Item Selectable Range or Selections Default Value Setting
Coment txt block no 1to 50 1
Line > 1 > Comment txt field no 1to 100 1
Line > 2 > Comment txt field no 1to 100 1
Line > 3 > Comment txt field no 1to 100 1
Line > 4 > Comment txt field no 11to 100 1
Line > 5 > Comment txt field no 1to 100 1
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Setup Items and Default Values

Timer, Event action > Timer

Setup Item Selectable Range or Selections Default Value Setting
Timer No. 1/2/3/4 1
1/2/3/.../11/12 (on models with the /BT2 multi
batch option)*2
Mode Off/Relative/Absolute Off
Relative > Interval 00:01 to 24:00 01:00
Relative > Reset at Math Start On/Off On
Absolute > Interval 1min/2min/3min/4min/5min/6min/10min/ 1h
12min/15min/20min/30min/1h/2h/3h/4h/
6h/8h/12h/24h
Absolute > Ref.time 0to 23 0:00
Timer, Event action > Match time timer
Setup Item Selectable Range or Selections Default Value Setting
Timer number 1/2/3/4 1
1/2/3/.../11/12 (on models with the /BT2 multi
batch option)“2
Kind Off/Day/Week/Month/Year Off
Day 1 to 31 (varies depending on the month) 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour 00:00 to 23:59 00:00
Timer action Single/Repeat Repeat
Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value  Setting
Logic box nhumber 1/2/3/...139/40 1
Event None/Remote/Relay/Switch/Timer/ None
Matchtime/AIarm/UserKey/EventLeveISwitch*2/
EventEdgeSwitch*Z/
Relay-Off */Switch-Off >/Alarm-Off /
EventLevelSwitch-Off °
Remote > Remote number 1/2/3/4/5/6/7/8 1
Relay > Relay number 101/.../106 (Depends on the option.) 101
Switch > Switch No. S01/S02/S03/.../S29/S30 S01
Timer > Timer No. 1/2/3/4 1
1/2/3/...111/12 (on models with the /BT2 multi
batch option)*2
MatchTimeTimer > Match Time Timer 1/2/3/4 1
No. 1/2/3/...111/12 (on models with the /BT2 multi
batch option) 2
EventLevelSwitch > Event Switch No 2 1/2/3/.../29/30 1
EventEdgeSwitch > Event Switch No2  1/2/3/.../29/30 1
Relay-Off > Relay number > 101/.../106 (Depends on the option.) 101
Switch-Off > Switch No.” S01/S02/S03/.../S29/S30 S01

EventLevelSwitch-Off > Event Switch
No™*

1/2/3/...130
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Setup Items and Default Values

Setup Item Selectable Range or Selections Default Value  Setting
Action MemoryStart/Stop, MemoryStart, MemoryStop, Group
Trigger (not selectable on a DX with the /AS1
option*z’) , AlarmACK, AIarmDispIayReset'Z,
MathStart/Stop, MathStart, MathStop, MathReset,
SaveDisplay, SaveEvent, Message, Snapshot,
DisplayRate1/2, ManualSample, TimerReset,
DisplayGroupChange, FavoriteDispIayQ,
CommentDispIay'z, Flag, PanelLoad (not
selectable on a DX with the /AS1 optionxa) ,
TimeAdjust (Depends on the events, etc)

Message > Message No. 110 100 1

Message > Write to AlllSelect All

Message > Group number 1/2/3/.../19110 1

Group > Group numbe 1/2/31.../0/10 1

FavoriteDisplay > Action Key/Select Key

FavoriteDisplay > Select

> Favorite Spcrgen No 11213/4/5/617/8 1

CommentDispla

> Comment 'Ith élock No 2 11050 1

Flag > Flag number 1;32;:/5/6/7/8 1

TimerReset > Timer No. 1/2/3/.../41/12 (on models with the /BT2 multi !
batch option)*2

PanelLoad > Setting file number 11213 1

The following menus appear when the multi batch function? is in use.

MemoryStart/Stop > Target Action All/Select All

MemoryStart/Stop > Select

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

MemoryStart > Target Action All/Select All

MemoryStart > Select

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

MemoryStop > Target Action All/Select All

MemoryStop > Select

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

SaveDisplay > Target Action All/Select All

SaveDisplay > Select

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

SaveEvent > Target Action All/Select All

SaveEvent > Select

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

MathReset > Target Action All/Select All

MathReset > Select

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

Message > Message No. 1to 100 1

Message > Write to All/Select All

Message > Select

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

> Display Group No 1/2/3/4/5/6 1

Message > All

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

DisplayGroupChange

> Batch Group No 1/2/3/4/5/6 (varies depending on settings) 1

DisplayGroupChange

> Display Group No 1/2/3/4/5/6 1
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Setup Items and Default Values

Data save > File header, File name

Setup Item Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less -
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less —
Data save > Save directory
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less DATAO
Data save > Event data
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/30s/60s  1s
/120s/300s/600s/15min 2/20min %/30min
(Depends on the model.)
Mode Free/Single/Repeat Free
Data length 10min to 31day (Depends on the sample rate.) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On
With /AS1”
The Sample rate and Data length items are the same as on a DX without the /AS1 option.
Mode Fixed at Free Free
There are no Pre-trigger or Trigger signal > Key items.
Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
Text field number 1t024° 1
Text field > Title of field 20 characters or less -
Text field > Characters 30 characters or less -
Web Report”
Setup Item Selectable Range or Selections Default Value Setting
Web Report No 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off
Title 64 characters or less -
Item No 1-5/6-10 1-5
ltem>11to 10 On/Off Off
Iltem > 1 to 10 > Channel R01/R02/.../R24 RO1
Iltem > 1 to 10 > Value Max/Min/Ave/Sum/Inst Sum
Iltem > 1 to 10 > Name 16 characters or less —
Menu customize
Setup Item Selectable Range or Selections Default Value Setting
Function menu Select/Hide/View/Transfer -
Display menu Separate/Select/Hide/View/Transfer -
End (/AS1 option) 3
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No -
Basic setting mode”
Setup Item Selectable Range or Selections Default Value Setting

Entering basic setting mode. ...

Yes/No
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Setup Items and Default Values

Multi batch tab?

Group set, Trip line > Group set?

Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group  1/2/3/4/5/6 (varies depending on settings) 1
Display Group No 1/2/3/4/5/6 1
Set Display Group > On/Off On/Off Off
Set Display Group > Group name 16 characters or less BATCH-1, etc.
Set Display Group > CH set 23 characters or less Depends on the model.
Group set, Trip line > Trip line
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group  1/2/3/4/5/6 (varies depending on settings) 1
Display Group No 1/2/3/415/6 1
Trip line

1,2,3,4 On/Off Off

Position 0to 100 50

Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green

3:Blue, 4:Yellow

Width 1/2/3 2
File header, File name 2
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group  1/2/3/4/5/6 (varies depending on settings) 1
File header > Characters 50 characters or less -
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less -
Data save > Batch text 2
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group  1/2/3/4/5/6 (varies depending on settings) 1
Text field number 1to 24 1
Text field > Title of field 20 characters or less -
Text field > Characters 30 characters or less -
End (/AS1 option)™
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No -

. . *3
Set Calibration Tab
Setup Item Selectable Range or Selections Default Value Setting
Calibration correction Same as Meas channel > Calibration correction
Finish Calibration > Next calibration due Year, month, and date —
Finish Calibration > Execute - -
End (/AS1 option)™
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No —
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Setup Items and Default Values

Day+Month

. *2
File tab
Load display data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Load event data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Load settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Save settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
File name 32 characters or less -
Custom display load > Select 2
Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25  Internal 1
File selection screen - —
Custom display load > All 2
Setup Item Selectable Range or Selections Default Value Setting
Directory selection screen - —
Custom display save > Select 2
Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25  Internal 1
File name 32 characters or less —
Custom display save > All 2
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less —
File list/delete (Delete is not available on DXs with the /AS1 option.) 3
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Load template 3
Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, —
Day+Month
Save template 3
Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, -

Template data save > File name

32 characters or less
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Setup Items and Default Values

Format (Without /AS1)

Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Format > VVolume name 11 characters or less -

End (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
End Yes/No —
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Setup Items and Default Values

This section uses the following notations in tables.

*1: This indicates functions that are available for release number 2 or later.
*2: This indicates functions that are available for release number 3 or later.
*3: This indicates functions that are available for release number 4 or later.

Environment tab >

Operating environment

Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag

Language English/Japanese/German/French/Chinese English

Remote Controller ID Off/0/1/.../130/31 Off

Temperature C/F C

Decimal Point Type*2 Point/Comma Point

Basic setting mode Menu display * On/Off On

View, Message

Setup Item Selectable Range or Selections Default Value Setting
View > Trend type T-Y T-Y

View > Partial On/Off Off

View > Trend rate switching On/Off Off

Message > Write group Common/Separate Common

Message > Power-fail message On/Off Off

Message > Change message On/Off Off

Input, Tag*2

Setup Item Selectable Range or Selections Default Value Setting
Input > Value on over-range Free/Over Over

Tag Basic settings > Tag No. Use/Not 2 Use/Not Not

Alarm > Action 2

Setup Item Selectable Range or Selections Default Value Setting
No logging On/Off Off

Annunciator mode On/Off Off

Sequence? ISA-A-4/ISA-A/ISA-M ISA-A

Time off color 2 White/Green Green

Alarm > Level/Color 2

Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4

Color > 1 Red/Yellow/Orange/Pink Red

Color > 2 Red/Yellow/Orange/Pink Red

Color>3 Red/Yellow/Orange/Pink Red

Color > 4 Red/Yellow/Orange/Pink Red

Remote

Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4

Remote Input > 1 N.O/N.C N.O

Remote Input > 2 N.O/N.C N.O

Remote Input > 3 N.O/N.C N.O

Remote Input > 4 N.O/N.C N.O

Remote Input > 5 N.O/N.C N.O

Remote Input > 6 N.O/N.C N.O

Remote Input > 7 N.O/N.C N.O

Remote Input > 8 N.O/N.C N.O
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Setup Items and Default Values

Security, Media save

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Security > Key Off/Login/Keylock Off

Security > Communication Off/Login Off

Save > Auto save On/Off On

Save > Media FIFO™ On/Off off

With /AS1”

Security > Key Login Login

Security > Communication Off/Login Off

Security > Multi login On/Off Off

Security > Password management On/Off Off

The Save items are the same as on a DX without the /AS1 option.

Batch

Setup Item Selectable Range or Selections Default Value Setting
On/Off On/Off/MultiBatch @ Off (With /AS1, On)

Lot-No. digit Off/4/6/8 6

Auto increment On/Off On

Batch operation qty*2 2/3/4/5/6 4

Communication > Service port

Setup Item Selectable Range or Selections Default Value Setting
FTP 1 to 65535 21

HTTP 1 to 65535 80

SNTP 1 to 65535 123

Modbus 1 to 65535 502

Communication > POP3 Details

Setup Item Selectable Range or Selections Default Value Setting
POP Before SMTP > Send delay [second] 0/1/2/3/4/5/6/7/8/9/10 2

POP3 Login PLANE/APOP PLAIN

Communication > FTP Server Details >

Setup Item Selectable Range or Selections Default Value Setting
Output Directory Format MS-DOS/UNIX MS-DOS

Math

Setup Item Selectable Range or Selections Default Value Setting
Value on Error +Over/-Over +Over

Value on Overflow > SUM, AVE Error/Skip/Limit Skip

Value on Overflow > MAX, MIN, P-P Over/Skip Over
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Setup Items and Default Values

Report

Setup Item Selectable Range or Selections Default Value  Setting
Report select > 1 Max/Min/Ave/Sum/Inst Ave

Report select > 2 Off/Max/Min/Ave/Sum/Inst Max

Report select > 3 Off/Max/Min/Ave/Sum/Inst Min

Report select > 4 Off/Max/Min/Ave/Sum/Inst Sum

File type Separate/Combine/Separate2'3 Separate

Use Template*3 Use/Not Not

End

Setup Item Selectable Range or Selections Default Value Setting

Do you want to store and
make the new settings take effect?

Yes/No/Cancel
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Setup Items and Default Values

*2
Menu tab
Alarm > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Reflash On/Off/On-1s°/On-2s™ Off

Rate of change > Decrease
Rate of change > Increase
Indicator

1to0 32
1to 32
Hold/Nonhold

1
1
Nonhold

Alarm > Switch, Relay

Setup Item Selectable Range or Selections Default Value Setting
Internal Switch > AND None/S01/S01-S02/.../S01-S29/S01-S30 None

Relay > AND None/I01/101-102/.../101-106 (Depends on the option.)  None

Relay > Action Energize/De_energ Energize

Relay > Hold Hold/Nonehold Nonhold

Relay > Relay Action on ACK Normal/Reset Normal

Alarm > Hysteresis

Setup Item

Selectable Range or Selections

Default Value Setting

Meas CH > High/Low 0.0t0 5.0 0.5
Meas CH > Delta High/Low 0.0t0 5.0 0.0
Math CH > High/Low 0.0t0 5.0 0.0
A/D, Memory
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Scan interval > Scan mode Normal/Fast Normal
Normal > Scan interval 125ms/250ms (DX1002, DX1002N, DX1004, DX1004N)  125ms
1s/2s/5s (DX1006, DX1006N, DX1012, DX1012N) 1s
Normal > A/D integrate Auto/50Hz/60HZz/100ms Auto
Fast™> Scan interval 25ms (DX1002, DX1002N, DX1004, DX1004N) 25ms
125ms (DX1006, DX1006N, DX1012, DX1012N) 125ms
Fast™> A/D integrate 600Hz 600Hz
Memory > Data kind Display/E+D/Event Display
With /AS1”
The Scan interval items are the same as on a DX without the /AS1 option.
Memory > Data kind Display/Event Display

t: You cannot select this option on a DX with external input channels (/MC1) or when the multi batch function (/BT2) is in use.

Signature (/AS1 option)*?’

Setup Item Selectable Range or Selections Default Setting
Value

Process type Batch/Continue Batch

Sign from recorder Off/Sign1/Sign1+2/Sign1+2+3 Off

Signature at batch stop On/Off Off

FTP transfer at signing On/Off Off

Burnout, RJC

Setup Item

Selectable Range or Selections

Default Value Setting

First-CH, Last-CH

Channel number

001

Burnout set > Mode Off/Up/Down Off
RJC > Mode Internal/External Internal
RJC > Volt —20000 to 20000uV 0

IM 04L41B01-02E

81

O
o
o
c
=3
<
o
c
o
)

pue swdy| dnjag




Setup Items and Default Values

Keylock > Password, Key action, Media (Without /AS1)

Setup Item Selectable Range or Selections Default Value Setting
Password 8 characters or less -

Key action > START Free/Lock Free

Key action > STOP Free/Lock Free

Key action > MENU Free/Lock Free

Key action > USER Free/Lock Free

Key action > DISP/ENTER Free/Lock Free

Key action > FAVORITE Free/Lock Free
Media/USB > External media Free/Lock Free
Media/USB > Load settings*2 Free/Lock Free
Keylock > Action of Function (Without /AS1)

Setup Item Selectable Range or Selections Default Value Setting
Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free
Login > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Auto logout Off/1min/2min/5min/10min Off
Operation without Login Off/Display Off

With /AS1”

Auto logout Off/1min/2min/5min/10min Off
Operation without Login Off/Display Off

User ID Use/Not Use
Password retry frequency 3/5/0ff 3

Root password > Password 20 characters or less 2??7°?7°7?
Login > Admin settings

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Admin number 1t05 1

Mode Off/Key/Comm/Web/Key+Comm Off

User name 20 characters or less Admin1 etc.
Password 20 characters or less 2?°?°°?7°7?
With /AS1”

Admin number 1t05 1

Mode Off/Key/Web/Key+Comm Off

User name 20 characters or less Admin1 etc.
User ID 8 characters or less -

Password 20 characters or less 20?0?77
Password expire Off/1month/3month/6month Off
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Setup Items and Default Values

Login > User settings

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

User number 1to 30 1

Mode Off/Key/Comm/Web/Key+Comm Off

User name 20 characters or less User1 etc.
Password 20" characters or less 2?2°?°°?7?
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off

With /AS1™

User number 1to 90 1

Mode Off/Key/Comm/Web/Key+Comm Off

User name 20 characters or less User1 etc.
User ID 8 characters or less -
Password 20 characters or less Yeaddaads
Password expire Off/1month/3month/6month Off
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off
Login > Authority of user > Key action, Media

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Authority of user 1/2/3/4/5/6/7/8/9/10 1

Key action > START Free/Lock Free

Key action > STOP Free/Lock Free

Key action > MENU Free/Lock Free

Key action > USER Free/Lock Free

Key action > DISP/ENTER Free/Lock Free

Key action > FAVORITE Free/Lock Free
Media/USB > External media Free/Lock Free
Media/USB > Load settings'2 Free/Lock Free
Authority of user 1/2/3/4/5/6/7/8/9/10 1

Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free
With /AS1”

The Authority of user, Key action, and Media/USB items are the same as on a DX without the /AS1 option.
Actions > AlarmACK Free/Lock Free
Actions > Message/Batch Free/Lock Free
Actions > Math Free/Lock Free
Actions > Data save Free/Lock Free
Actions > E-mail/FTP Free/Lock Free
Actions > Time set Free/Lock Free
Actions > Display Function Free/Lock Free
Action > Calibration Free/Lock Free

Sign record > Signature1 Free/Lock Free

Sign record > Signature2 Free/Lock Free

Sign record > Signature3 Free/Lock Free
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Setup Items and Default Values

Report > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month  Off
Date 110 28 1
Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Time (hour) 0to 23 0:00
Report > Report settings
Setup Item Selectable Range or Selections Default Value Setting
Report channel number R01/R02/R03/.../R23/R24 RO1
On/Off On/Off Depends on
the model
Channel Channel number 001 etc.
Sum scale Off, /s, /Imin, /h, /day /s
Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time zone (HHMM) —1300 to 1300 900
Time deviation limit Off/10s/20s/30s/1min/2min/3min/4min/5min 30s
Date format Y/M/D, M/D/Y, DIM/Y, D.M.Y Y/M/D
Calender display > 1st weekday*2 SUN/MON MON
Communication (Ethernet) > IP-address
Setup Item Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > IP-address 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Subnet mask 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Default gateway 0.0.0.0 to 255.255.255.255 0.0.0.0
Communication (Ethernet) > Host settings
Setup Item Selectable Range or Selections Default Value Setting
Host name 64 characters or less —
Domain name 64 characters or less —
Communication (Ethernet) > DNS settings
Setup Item Selectable Range or Selections Default Value Setting
Server search order > Primary 0.0.0.0 to 255.255.255.255 0.0.0.0
Server search order > Secondary 0.0.0.0 to 255.255.255.255 0.0.0.0
Domain suffix search order > Primary 64 characters or less -
Domain suffix search order > Secondary 64 characters or less —
Communication (Ethernet) > Keep alive, Timeout
Setup Item Selectable Range or Selections Default Value Setting
Keep alive On/Off On
Application time out > On/Off On/Off Off

Application time out > Time

1to 120 (min)

1
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Setup Items and Default Values

Communication(Ethernet) > Server > Server modes

Setup Item Selectable Range or Selections Default Value Setting
FTP Use/Not Use™
Web Use/Not Use
SNTP Use/Not Not
Modbus Use/Not Not
PLC communication protocol 2 Use/Not Not
Communication(Ethernet) > Server > Allowed Modbus clients™
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Client number 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off
Communication (Ethernet) > Web page
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Page type Operator/Monitor Operator
Page type=Operator
Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off
Web page > Command Use/Not Not
Page type=Monitor
Web page > On/Off On/Off Off
Web page > Access control Off/Admin/User Off
With /AS1”
Page type Operator/Monitor Operator
Page type=Operator
Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off
The items when Page type is set to Monitor are the same as on a DX without the /AS1 option.
Communication (Ethernet) > E-Mail > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
SMTP server name 64 characters or less -
Port number 0 to 65535 25
Security Off/PbS ?/Auth Off
SMTP authorization > User name 32 characters or less -
(when Auth is selected)*3
SMTP authorization > Password 32 characters or less -
(when Auth is selected)*3
Communication (Ethernet) > E-Mail > Recipients
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 150 characters or less —
Recipient 2 150 characters or less -
Sender 64 characters or less -
Communication (Ethernet) > E-Mail > POP3 settings*2
Setup Item Selectable Range or Selections Default Value Setting
POP3 Server name 64 characters or less -
Port number 0 to 65535 110
Login name 32 characters or less —
Password 32 characters or less i
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Setup Items and Default Values

Communication (Ethernet) > E-Mail > Alarm settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Recipient 2 On/Off Off

Active Alarms > Alarm 1 On/Off Off

Active Alarms > Alarm 2 On/Off Off

Active Alarms > Alarm 3 On/Off Off

Active Alarms > Alarm 4 On/Off Off

Include INST On/Off Off

Include source URL On/Off Off

Subject 32 characters or less Alarm_summary
Header 1 64 characters or less —

Header 2 64 characters or less —

Send alarm action > On+Off/On On+Off

Include tag/ch in Subject 2 On/Off Off
Communication (Ethernet) > E-Mail > Scheduled settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h

Ref.time 00:00 to 23:59 00:00

Recipient 2 On/Off Off

Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h

Ref.time 00:00 to 23:59 00:00

Include INST On/Off Off

Include source URL On/Off Off

Subject 32 characters or less Periodic_data
Header 1 64 characters or less -

Header 2 64 characters or less —

Communication (Ethernet) > E-Mail > System settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Recipient 2 On/Off Off

Include source URL On/Off Off

Subject 32 characters or less System_warning

Header 1 64 characters or less -

Header 2 64 characters or less —

Communication (Ethernet) > E-Mail > Report settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Recipient 2 On/Off Off

Include source URL On/Off Off

Subject 32 characters or less Report_data

Header 1 64 characters or less -

Header 2 64 characters or less —
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Setup Items and Default Values

Communication (Ethernet) > FTP client > FTP transfer file

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP transfer file > Snapshot On/Off Off
Transfer wait time > Disp&Event data 2 0 to 120 min 0
Transfer wait time > Report*2 0 to 120 min 0
With /AS1”

FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP transfer file > Snapshot On/Off Off
FTP transfer file > Setting On/Off Off

The Transfer wait time items are the same as on a DX without the /AS1 option.

Communication (Ethernet) > FTP client > FTP connection

Setup Item Selectable Range or Selections Default Value Setting
FTP connection Primary/Secondary Primary

FTP server name 64 characters or less —

Port number 0 to 65535 21

Login name 32 characters or less —

Password 32 characters or less |

Account 32 characters or less -

PASV mode On/Off Off

Initial path 64 characters or less -

Communication (Ethernet) > SNTP client

Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not

Server name 64 characters or less —

Port number 0 to 65535 123

Access interval Off/1h/8h/12h/24h 8h

Access reference time 00:00 to 23:59 00:00

Access timeout 10s/30s/90s 30s

Time adjust on Start action On/Off Off

Communication (Ethernet) > Modbus client > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Retry interva Off/10s/20s/30s/1min/2min/5min/10min/ 2min

20min/30min/1h

Communication (Ethernet) > Modbus client > Modbus server settings

Setup Item Selectable Range or Selections Default Value Setting
Server number 1-8/9-16 1-8

Port 0 to 65535 502

Modbus server name 64 characters or less -

Unit Auto/Fixed Auto

No. 0 to 255 1
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Setup Items and Default Values

Communication (Ethernet) > Modbus client > Command settings

Setup Item Selectable Range or Selections Default Value Setting

Client command number 1-8/9-16 1-8

1t0 16 Off/R/R-M/W/W-M/E-M™ off

First Depends on the command type. -

Last Depends on the command type. —

Server 1/2/3/.../15/16 1

Regi. Numerical value 30001

Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16
UINT32_L/FLOAT_B/FLOAT L

Communication (Ethernet) > Password management > KDC connection (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting

KDC connection Primary/Secondary Primary

KDC server name 64 characters or less -

Port number 0 to 65535 88

Communication (Ethernet) > Password management > Certification key (/AS1 option)*e'

Setup Item Selectable Range or Selections Default Value Setting

Host principal 20 characters or less —

Realm name 64 characters or less -

Password 20 characters or less -

Encryption AES128/AES256/ARC4 AES128

Communication (Serial) > Basic settings

Setup Item Selectable Range or Selections Default Value Setting

Without /AS1

Baud rate 1200/2400/4800/9600/19200/38400 9600

Data length 718 8

Parity Odd/Even/None Even

Handshaking Off:Off XON:XON/XON:RS/CS:RS Off:Off

Address 1to 99 1

Protocol Normal/Modbus/Modbus-M Normal

With /AS1”

The baud rate, data length, parity, handshaking, address items are the same as on a DX without the /AS1 option.

Protocol Normal/Modbus/Modbus-M/Barcode Normal

Communication (Serial) > Modbus master > Basic settings

Setup Item Selectable Range or Selections Default Value Setting

Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s

Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s

Retrials Off/1/2/3/4/5/10/20 1

Inter-block delay Off/5ms/10ms/15ms/45ms/100ms Off

Auto recovery Off/1min/2min/5min/10min/20min/30min/1h 2min

Communication (Serial) > Modbus master > Command settings

Setup Item Selectable Range or Selections Default Value Setting

Master command number 1-8/9-16 1-8

110 16 OffIR/IR-M/W/W-M" Off

First Depends on the command type. -

Last Depends on the command type. -

Addr. 1to0 247 1

Regi. Numerical value 30001

Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT L
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Setup Items and Default Values

Communication (PROFIBUS-DP)?

Setup Item Selectable Range or Selections Default Value Setting
Node Address 0to 125 3

Status relay*3

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Fail relay Fail/Status relay Fail

Status relay Fail/Status relay Status relay

With /AS1

Fail relay Fail/Status relay/Mem. sample/Invalid user/Login  Fail

Status relay Fail/Status relay/Mem. sample/Invalid user/Login  Status relay

Status Relay > Status Relay Details™

Setup Item Selectable Range or Selections Default Value Setting
Memory/Media status On/Off Off
Measurement error On/Off Off
Communication error On/Off Off
Memory stop On/Off Off
Alarm* On/Off Off

Set Calibration

Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not

Notification 1t0 10 1

Renotification 10min/30min/1h/8h/24h 1h

End

Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and Yes/No/Cancel -

make the new settings take effect?
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Setup Items and Default Values

File/Initialize tab >
Load settings

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Load settings > Kind CF/USB CF

Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3

Media eject CF/USB -

With /AS1”

Load settings > All settings > Kind CF/USB CF

Load settings > Login info only > Kind CF/USB CF

Load settings > Other settings > Kind CF/USB CF

Initialize > Kind Clear 1/Clear 2/Clear 3/Clear 4 Clear 3

Media eject CF/USB -

End

Setup Item Selectable Range or Selections Default Value Setting

Do you want to store and
make the new settings take effect?

Yes/No/Cancel

90
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